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Legal notes 
© 2014 ISD ® Software und Systeme GmbH. All rights reserved. 

This User Guide and the software described herein are provided in conjunction with a license and may only 
be used or copied in accordance with the terms of the license. The contents of this User Guide solely serve 
the purpose of information; it may be modified without prior notice and may not be regarded as binding for 
the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not assume any 
responsibility for the correctness or accuracy of the information provided in this document. No part of this 
document may be reproduced, saved to databases or transferred in any other form without prior written 
permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license 
agreement.  

All mentioned products are trademarks or registered trademarks of their respective manufacturers and 
producers. 

 

The license management portion of this Licensee Application is based upon one or more of the following 
copyrights: 

Sentinel®RMS 
© 1989-2006 SafeNet, Inc. 
All rights reserved. 
 
Sentinel®EMS™ 
© 2008-2009 SafeNet, Inc. 
All rights reserved. 
 
Sentinel® is a registered trademark of SafeNet, Inc.  

 

This work contains the following software owned by Siemens Industry Software Limited: 

D-CubedTM 2D DCM © 2013. Siemens Industry Software Limited. All Rights Reserved. 

D-CubedTM 3D DCM © 2013. Siemens Industry Software Limited. All Rights Reserved 

D-CubedTM AEM © 2013. Siemens Industry Software Limited. All Rights Reserved. 

 

PDF3D® 

© 2003-2011 Visual Technology Services Ltd. All rights reserved. Is a registered trademark of Visual 
Technology Services Ltd.  
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Copyright 2008, Google Inc. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

    * Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

    * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

    * Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when 
generating it.  This code is not standalone and requires a support library to be linked with it.  This support 
library is itself covered by the above license. 

 

Lp_solve 

HiCAD uses the library lp_solve.  

lp_solve is a free library under the LPGL license (Lesser Public General License) of the Free Software 
Foundation.  

Details on the licensing can be found at http://lpsolve.sourceforge.net/5.5/LGPL.htm  

http://lpsolve.sourceforge.net/5.5/LGPL.htm
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1 System Requirements 

 

 

1.1 Hardware Requirements for HiCAD 
For the installation of HiCAD you can use any hardware that possesses current drivers 
for the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set. You also require a DVD drive.  
 

Hardware requirements (minimum) 

Processor (CPU): Pentium 4 compatible processor with SSE2 support 

RAM: 4 GB RAM 

Hard disk: approx. 5 GB free disk space 

Screen resolution 1280 x 1024 

Graphics card: Fully OpenGL capable graphics card with at least 128 
MB memory (if the error message Set Pixel Format 
failed is displayed during program start, the OpenGL 
driver does not support the entire instruction set). You 
can use the OpenGLCapabilityTester to check whether 
the OpenGL capabilities of your computer are 
sufficient for HiCAD. This tool is available for download 
in the ISD Wiki at FAQ > System Requirements > 
HiCAD. 

Other: For the output of reports, e.g. Sheet Metal cost 
calculations, you require Microsoft Office Version 2010 
or higher. 

 

Please note: 

HiCAD 2015 (Version 2000.0) will be the first version that will only be available as 
a 64Bit Version. Starting from this version, no 32Bit version of our CAD software 
will be available any more. 

http://www.hicad.isdgroup.de/cms/dofiles/f_2402_865111e944a215c345d37ddd03418326_0_openglcapabilitytesterpzip.zip
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
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 To achieve optimal performance for large assemblies, the system should possess 
significantly more main memory than is considered sufficient for HiCAD at first glance. This 
enables the hard disk accessing operations Buffer memory, Undo and Switch drawing to be 
performed up to 4 times faster. 

 

» Supported operating systems: 

 Windows 8 

 Windows 7 (with current service pack and security patches) 

» Supported database systems (for HiCAD with HELiOS): 

 Microsoft SQL Server 2000 / 2005 / 2008 / 2012  

 Oracle Database Server 10g / 11g R2 

There are no further requirements for the installation of the HiCAD Version with License 
Management; the legal licensing check is performed during runtime.  
 

Recommended hardware equipment (October 2014) 

Computer: Fujitsu CELSIUS M730 

Processor (CPU): Intel Xeon E5-1650v, 3.5 GHz, 12 MB Cache 

RAM: 16 GB, DDR3-RAM, 1333 MHz 

Hard disk: 1 SSD SATA III 512 GB, 2.5 inch 

Graphics card: NVIDIA Quadro K4000 (3 GB) 

Screen resolution Full HD (1920x1080) 

Operating system: Microsoft Windows 8.1 (64 Bit)  

Other: Microsoft Office Version 2010 or higher 
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» Graphic cards 
The following graphic cards are recommended for HiCAD operation (tested on 
Windows 7  

 

Supplier Model Graphic drivers (tested) 

Nvidia NVIDIA Quadro K2000 (2 GB 
GDDR5) 

332.50 

 NVIDIA Quadro K4000 (3 GB 
GDDR5) 

332.50 

 NVIDIA Quadro K5000 (4 GB 
GDDR5) 

332.50 

AMD FirePro W5000 (2 GB GDDR5) 13.251.1 

 FirePro W7000 (4 GB GDDR5) 13.251.1 

 FirePro W8000 (4 GB GDDR5) 13.251.1 

 

 Please note that insufficient graphics hardware will impair the performance and the 
quality of graphical representation!  
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1.2 System Requirements for HELiOS Desktop (Standalone) 
For the installation of HELiOS you may use any hardware possessing current drivers for 
the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set. Furthermore, a DVD drive is 
required. 

 

Hardware requirements (minimum) 

Processor (CPU): Pentium 4 compatible processor with SSE2 support 

RAM: 1 GB RAM 

Graphics card: Fully OpenGL capable graphics card with at least 128 
MB memory (if the error message Set Pixel Format 
failed is displayed during program start, the OpenGL 
driver does not support the entire instruction set). You 
can use the OpenGLCapabilityTester to check whether 
the OpenGL capabilities of your computer are 
sufficient for HiCAD. This tool is available for download 
in the ISD Wiki at FAQ > System Requirements > 
HiCAD. 

Operating system: Windows 7 (with current service pack and security 
patches) 

Windows 8 

Database systems: Microsoft SQL Server 2000 / 2005 / 2008 / 2012 

Oracle Database Server 10g / 11g R2 

 

Recommended hardware for simultaneous HiCAD operation 

Computer: Fujitsu CELSIUS M730 

Processor (CPU): Intel Xeon E5-1650v, 3.5 GHz, 12 MB Cache 

RAM: 16 GB, DDR3-RAM, 1333 MHz 

Hard disk: 1 SSD SATA III 512 GB, 2.5 inch 

http://www.hicad.isdgroup.de/cms/dofiles/f_2402_865111e944a215c345d37ddd03418326_0_openglcapabilitytesterpzip.zip
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
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Graphics card: NVIDIA Quadro K4000 (3 GB) 

Screen resolution Full HD (1920x1080) 

Operating system: Microsoft Windows 8.1 (64 Bit)  
 

» Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed 
on the computer before HELiOS can be used; these packages will be installed by the 
HELiOS installer if required. 

» To be able to work with HELiOS, a database system must be available that has been 
prepared for HELiOS. For this you require 

 A Microsoft SQL Database Management system on your Server, 

 A HELiOS database imported with the HELiOS Database Creator and  

 An ODBC connection on the Clients. 

Documents (in .pdf format) describing the installation procedure for the database 
system and the import and export of the database can be found in the Wiki at Product 
Know-how > Documentation > HELiOS.  
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1.3 Hardware Requirements License Server 
 

Processor (CPU): x86 Processor for 32-Bit / x86-64 Processor for 64-Bit 

Recommended: 2 GHz Processor 

RAM: Minimum: 1 GB  

Recommended: 2 GB (with SQL Server: > 3 GB ) 

Hard disk: 1.2 GB free disk space 

Operating System 
(Server) 

Windows Server 2008 (32 & 64Bit) 

Windows Server 2008 R2 (32 & 64Bit) 

Windows Server 2012  

Windows 7 (32 & 64-Bit) 

Operating system  
(Client) 

Windows Vista (32 & 64-Bit) 

Windows 7 (32 & 64-Bit) 

Windows 8 (32 & 64-Bit) 

IP/MAC Adress A static IP address is required for an error-free 
operation of the license server. 

For virtual servers a static MAC address needs to be 
available.  

 

 Please note:  

 As of Version 1700, parallel installations of license servers and ISD products (i.e. on 
the same computer) are no longer covered by the warranty. The ISD group advises 
you strongly not to perform such installations.   

 A static IP address is required for a correct operation of the License Server! 
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 A license server program does not need to run on a file server system or any specific 
hardware server. Suitable is any computer that fulfils the requirements.  
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1.4 Hardware Requirements HiCAD Spooler 
The system requirements for the Plot Spooler are identical to those for a normal HiCAD 
Client (please see System Requirements for HiCAD). The RAM should be at least as 
large as the RAM for the existing HiCAD Clients. The reason for this is that the Plot 
Spooler must be able to perform, besides automation tasks, various other tasks such as 
the conversion of HiCAD drawings (to 3D-PDF or similar). 

Besides the Client operating systems Windows 7 und 8 you can also use the Server 
operating systems Windows Server 2008 or Windows Server 2012. Whether a Server 
operating system needs to be used depends on the licensing conditions for the 
Microsoft operating system that you use. The decisive factor is the number of permitted 
simultaneous device connections. 

» Windows 7 and 8 allow 20 simultaneous connections. This will be sufficient for 20 
Print Clients, if all of them are actually running at the same time. Please note 
however that each connection from a non-HiCAD/HELiOS workstation will reduce this 
number. 
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1.5 Hardware Requirements Vault Server 
 

Processor (CPU): Pentium III-compatible processor, Minimum: 1,0 GHz 

RAM: Minimum: 1 GB, Recommended: 4 GB or more 

Graphics card: VGA (no special requirements) 

Hard disk: For software: 100 MB 

For user data: Depending on the amount of data to be 
expected, plus backup memory of >= 100%  

(distribution over several volumes/drives possible, 
redundant array of independent disks (RAID) for primary 
user data recommended) 

Operating system 
(virtual servers also 
possible): 

 

Windows 7 Professional 
Windows 7 x64 Professional 

Windows 8 Professional 
Windows 8 x64 Professional 

Windows Server 2003 SP2 
Windows Server 2003 SP2 x64  

Windows Server 2003 R2 SP2 
Windows Server 2003 R2 SP2 x64 

Windows Server 2008 SP2 
Windows Server 2008 SP2 x64  

Windows Server 2008 R2 x64  

Windows Server 2012 
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1.6 Hardware Requirements HELiOS Smart Search 
See 1.5 Hardware Requirements Vault Server 

 

1.7 Further Installation Requirements 
» Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed 

on the computer before HiCAD/HELiOS 2013 can be used; these packages will be 
installed as part of the HiCAD installation if required.  

» The graphics card must support Open GL 2.0 or higher. If the hardware or driver 
does not support this standard, there will be shown a warning message when 
installing HiCAD and a compatibility mode will be used (with low graphic 
performance). 

» If you use Nvidia graphics drivers, the Common background/Z-buffer needs to be 
switched Off (in contrast to HiCAD 2007 or older versions).  

» To be able to work with HELiOS, a database system must be available that has been 
prepared for HELiOS. Documents (in .pdf format) describing the installation 
procedure for the database system and the import and export of the database can be 
found in the Readme directory of the Installation DVD.   

» To be able to work with HELiOS, a database system must be available that has been 
prepared for HELiOS. For this you require 

 A Microsoft SQL Database Management system on your Server, 

 A HELiOS database imported with the HELiOS Database Creator and  

 An ODBC connection on the Clients. 

 Documents (in .pdf format) describing the installation procedure for the database 
system and the import and export of the database can be found in the Wiki at 
Product Know-how > Documentation > HELiOS.  

» Current information on system requirements can also be found on the Internet at 
www.isdgroup.com at Support > ISD Wiki > Product know-how  > FAQ. 
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2 Installation 
The DVD contains the installation files for:  

» HiCAD 

» HELiOS Desktop (Standalone) 

» The Online Help  

» The Vault Server 

» The Plot Management  

» HiCAD Viewer 

» The License Server (the Hardlock driver is normally no longer required) 

» The PostScript printer driver (required for the output of several views to a PDF file) 

» The HELiOS Database creator (to set up the HELiOS database for the very first time 
and import/export an existing database) 

The DVD has been developed for Windows operating systems. When you insert the 
DVD, an installation wizard will be started automatically. 

 

 The HiCAD and HELiOS version must be installed on the hard disk of the computer; it is 
not possible to start the programs from the DVD. 
 

If the Autostart function has been deactivated in the operating system, it is mandatory 
for the installation of HiCAD to start the setup.bat file from the root directory of the DVD; 
only in this way it is ensured that the version of the operation system (32/64Bit) will be 
recognised correctly, and the matching HiCAD version will be installed.   
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In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components.   

 

Leave this selection mask open, so that you can, one after the other, select the desired 
components.  
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2.1 Installing HiCAD 
 

 

 

Click the HiCAD and HELiOS button to start the installation.  

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be 
installed on the computer before HiCAD/HELiOS can be used; these packages will be 
installed as part of the HiCAD installation if required.  
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 

 

Specify an installation directory.  
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You can help us increase the user-friendliness of our products even further. To 
participate or terminate your participation, please activate the corresponding checkbox. 

You can terminate your participation at any time by choosing Help > Customer 
Feedback, and selecting the corresponding checkbox.  
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Data Protection notice: Collection of Data for Constant GUI Optimisation 

You can help us increase the user-friendliness of our products even further. If you 
participate, the ISD will collect information on your use of our software, in order to 
detect trends and use patterns.  This information will then be used for a constant 
optimisation of our user interface, with the aim to make the operation of our software as 
convenient and efficient as possible for our users. 

 
The collected information  

» Contains data on the functions that you used (frequency and chronological order). 

» Contains a key enabling the identification of your computer. It does not contain any 
personal data, and will not be used to detect your identity. The key will only be used 
to obtain data on the diffusion rate of customer feedback. For instance, it is important 
to know whether a functionality has been used 100 times by 1 customer, or whether 
another function has been used only once by 100 customers etc. 

» Will be automatically removed after transmission to the ISD.  In case of a failed 
transmission (e.g. because of network problems) the information will be automatically 
removed after 1 week at the latest when the program has been re-launched. 

» Will not cause a slowing down of the program operation. 

 
ISD will not 

» Store your name, address, or any other personal data. 

» Ask any further questions besides asking for your consent to the participation. 

» Use the data for any other purposes than those described above. 

» Contact you in any form in connection with your participation. 

 
You can choose to participate when installing the product for the first time. To terminate 
your participation at a later time, choose Help > Customer Feedback, and select the 
corresponding option.  
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Please read the Notes on Hardware exchange carefully. 

 

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware.  

 

Accept the notes to continue with the installation. 
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You can now start with the installation or modify the Extended Settings, e.g. for the user 
configuration, the catalogues, or HiCAD with HELiOS.  

 

In the Configuration Database, customer-specific settings for various features such as 
dimensioning, annotations, workshop drawing creation or fitting of vertical ladders are 
stored. When making an update, customer-specific settings can be applied. In addition, 
values that have not been modified by the user will automatically obtain the updated 
pre-settings.  
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Depending on the selection in this window, the settings stored in the CSV file, too, will 
be applied. The standard CSV files are located in the templates directory of the HiCAD 
installation. CSV files are configuration templates that you can create and edit with 
Microsoft Excel (please see Online Help). 

Parameter configuration: No templates (see 2.6 Parameter Configuration) is activated 
by default. You can also change this setting subsequently, via the programs 
..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe (for the 
User). 

 

The execution of the CatalogueMaker serves the purpose of specifying which standard 
series are to appear in the standard part catalogues (currently standard series are 
available for DIN, ISO, EN, ANSI and JIS); the selection of standards in the 
CatalogueMaker only influences the display of standard parts, but not their availability; 
the availability is still controlled via license selection in the ISD License Manager.    

When Updates are made, the existing configuration will be applied, and the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called via Start > All Programs > ISD Software und 
Systeme GmbH > Administration.  
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In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  

If you want to process your print jobs via the ISD Plot Management, you need to install 
one PrintClient on each workstation. In the Server field, enter the network name of the 
computer on which the Spooler is installed. The Spooler collects the print jobs and 
processes them, taking your settings into account.  
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The availability of interfaces with HELiOS depends on the programs that are installed on 
your computer. You can only link 32Bit versions to HELiOS 32Bit versions, and only link 
64Bit versions to HELiOS 64Bit versions.Multiple selections are also possible. The 
HELiOS functions will be integrated in the programs that are linked to HELiOS. 

 

 A compatibility matrix for the CAD systems can be found in the ISD Wiki at 
Product Know-how > FAQ > System & Hardware > HELiOS Desktop. 

 

 

You require the....license administration tools for the installation of server licenses.  

 Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be 
started. 

 



Installation 

   33 

 

Click Finish to complete your HiCAD installation. If desired, you can use the buttons of 
the installation mask to install further software components.  
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2.2 Installing HELiOS Desktop (Standalone) 
The HELiOS Desktop is normally installed automatically when you install HiCAD. Of 
course, you can also install HELiOS separately. To do this, start Windows. If Windows is 
already open, close all other applications. Insert the HELiOS DVD in your DVD drive. 
The installation wizard will be started automatically. Follow the instructions on the 
screen.  

 

In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components. Please leave this selection mask 
open, so that you can, one after the other, install the desired components.  

 

 

 

Click the HELiOS button. 
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Please read the Notes on Hardware Exchange carefully. 
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Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware. 

 

Accept the notes to continue with the installation. 

 

 

You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 
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In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  

If you want to process your print jobs via the the Plotmanagement of the ISD, you need 
to install a Print Client on each workstation. In the Server field, enter the name of the 
computer on which you install the Spooler. The Spooler collects the print jobs and 
processes them according to your settings.   
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The availability of interfaces with HELiOS depends on the programs that are installed on 
your computer. You can only link 32Bit versions to HELiOS 32Bit versions, and only link 
64Bit versions to HELiOS 64Bit versions.Multiple selections are also possible. The 
HELiOS functions will be integrated in the programs that are linked to HELiOS.  

 

 A compatibility matrix for the CAD systems can be found in the ISD Wiki at Product Know-how > 
FAQ > System & Hardware > HELiOS Desktop. 
 

 

You require the License Administration Tools for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

Close the Extended Settings dialogue with OK and start the installation. 
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After successful installation, you will find the HELiOS shortcut on the Desktop for 
program launch.  
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2.3 Installing the Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and 
on the Internet (regularly updated) at www.help.isdgroup.com. Both versions of the 
Help can be directly launched from HiCAD. Please note that corresponding login data 
are required to access the Internet version of the Help.  

Start Windows to install the Help. If Windows is already open, close all other 
applications. Insert the DVD in the drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

 

 

Click the HiCAD and HELiOS Help button. 

 

http://www.help.isdgroup.com/
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Specify the installation directory for HiCAD/HELiOS. 
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After successful installation, the Help can be found in the program folder and can be 
called via HiCAD/HELiOS.  
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2.4 Installing the Vault Server  
Start Windows to install the Vault Server. If Windows is already open, close all other 
applications. Insert the DVD in the DVD drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

 

 

Click the HELiOS Vault Server button. 
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Specify the installation directory of the Vault Server. 

 

Give the Vault Server a name, e.g. the name of your company, plus the location of your 
company. This name will be shown, for example, when you connect to the Vault Server 
from the Vault Client.  
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The Vault Server renames all documents that are managed in the database (e.g. SZA, 
DOC, XLS, …) to *.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file 
names to the “original file names”.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF 
files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server 
would also be possible here. If the log file exceeds a certain length, it will be cut down 
and suffixed by the current date. 
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Click the Install button.  

 

Click Finish to complete the installation of the Vault Server. You can now install further 
components offered in the selection mask if desired. 
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2.5 Installing the HiCAD Spooler  
The Plot Management consists of the following two components: 

» HiCAD PrintClient (part of the HiCAD installation; is installed on each workstation) 

» HiCAD Spooler (is installed on the Server only) 

Start Windows to install the components of the plot management. If Windows is already 
open, close all other applications. Insert the DVD in the DVD drive, which automatically 
starts the installation wizard. In the installation wizard, click the Standard Edition 
button, which opens a mask with various selection options for software components. 
Please leave this selection mask open, so that you can, one after the other, install the 
desired components.  

 

 

 

Click the HiCAD Spooler button. 
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 

 

Specify the installation directory for the software. 
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Please read the Notes on Hardware Exchange carefully. Accept the notes to continue 
with the installation.  

 

You can now click Install to start the installation, or modify the Extended settings, e.g. 
for the user configuration or the catalogues. The Extended Settings here are modified in 
the same way as the Extended Settings for the HiCAD. 

Then click Install. 
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After successful installation, the HiCAD Spooler will be located in the program folder.  
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2.6 Parameter Configuration 
HiCAD provides suitably customised interfaces and configurations for various fields of 
engineering, e.g. for Mechanical Engineering, Steel Engineering, Metal Engineering or 
Plant Engineering. You can select these options during the installation of HiCAD 
(Extended Settings > User Configuration > Use ISD Standard Templates).  

To change the parameter configuration subsequently, start the programs 

» ..exe/ParKonfigComp.exe for the workstation configuration, and 

» ..exe/ParKonfigUser.exe for the user configuration. 

 

In the dialogue window you have the following setting options:  

» Module 
Here you choose the required filed of engineering. The common HiCAD parameters 
are then configured for this area. 

» Font 
Specifies the text font default setting, e.g. for dimensioning, title blocks, view 
labelling, annotation etc. 
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» HiCAD/HELiOS Default Solution 
Provides you with a preconfigured database solution for a safe and convenient 
management of product data. If you want to use it, activate the checkbox.  

» Attribute configuration according to DSTV  
If you want the HiCAD attribute masks for parts and drawings to obtain the DSTV-
relevant attributes, please activate the appropriate checkbox. The files 
BRW_3DTEIL.HDX and BRW_SZENE.HDX in the HiCAD SYS directory will be preset 
for DSTV BOM configuration.  

» ISD standard template; Module: Steel Engineering: 
 

Short description Default  HiCAD configuration file  Line 

General: Zoom factor <F2>-Zoom 5.0 sys\grapar.dat 50 

General: Zoom window size <F2>-
Zoom 

0.9 sys\grapar.dat 52 

Type of weight calculation for 
beams+profiles  (1 = Exact volume * 
Density, 2 = DIN weight, Commercial 
weight) 

2 sys\stb_parameter.dat 9 

Type of weight calculation for 
plates+sheets (1 = Exact volume * 
Density, 2 = Length*Width*Thickness 
* Density) 

2 sys\stb_parameter.dat 9 

Representation of beams + profiles  
(0 = Simplified, 1 = Exact, 2 = Axis 
only) 

0 sys\stb_parameter.dat 19 

First Steel Engineering part item 
number 

100 sys\stb_parameter.dat 31 

Type of detection for first item 
number of main parts and sub-parts 
(1 = Start value, 2 = Factor, 3 = 
Allowance) 

3 sys\stb_parameter.dat 34 

Itemisation of Standard Parts (0 = No, 
1 = Yes) 

1 10000 sys\stb_parameter.dat 38 

Itemisation of non-Steel Engineering 
parts (0 = No, 1 = Yes) 

1 10000 sys\stb_parameter.dat 40 
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Short description Default  HiCAD configuration file  Line 

Consider boltings for identical part 
search 

1 sys\stb_parameter.dat 55 

Handling of existing item numbers 
when inserting Steel Engineering 
parts 

1 sys\stb_parameter.dat 86 

Consider part attributes for identical 
part search (0 = No, 1 = Yes) 

1 sys\stb_parameter.dat 126 

Consider database part master for 
identical part search (0 = No, 1 = 
Yes) 

1 sys\stb_parameter.dat 128 

Set negative item number for 
modified Steel Engineering parts  

1 sys\stb_parameter.dat 143 

Increment for assembly item numbers 1 sys\stb_parameter.dat 151 

Increment for Steel Engineering part  
item numbers 

1 sys\stb_parameter.dat 153 

Increment for Standard Part item 
numbers 

1 sys\stb_parameter.dat 155 

Increment for non-Steel Engineering 
part item numbers 

1 sys\stb_parameter.dat 157 

Tolerance for identical part search 0.5 sys\stb_parameter.dat 184 

» Copy HELiOS standard masks 
This option should only be activated if you work exclusively on the basis of the ISD 
standard database. Please note that changes you applied to database masks will be 
overwritten. 

» Starter Configuration 
If you want HiCAD to be preset so that the automatic procedures of the novice 
configuration apply, activate this checkbox.  

» Use own templates  
Activate this option if you want to use your own configurations. Then select the 
relevant configuration file.  



Installation 

 54 UNLIMITED PERFORMANCE 

2.7 Installing the HiCAD Viewer 
The HiCAD Viewer enables you to view drawings in HiCAD format (*.sza, *.szx) and 
output these drawings (in non-scale representation). This viewer is free of charge and 
may be provided free, without changing the scope of delivery.  
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2.8 Installing the HELiOS Database Creator 
The HELiOS PDM modules (Document management, Part Management, Workflow etc.) 
are based on a relational database. Before you put HELiOS into operation, the Microsoft 
SQL Server database administration system needs to be installed on the server, a 
HELiOS database needs to be imported and a ODBC connection needs tob e set up on 
the clients.  

When you set up a HELiOS database for the first time, the HELiOS Database Creator 
needs to be installed and executed on the database server first. The database and table 
structures will then be created, and filled with data records of the HELiOS standard 
database. 

 

 All information about the correct procedure for the execution of the HELiOS Database 
Creator, as well as the previous and subsequent steps required for the setting up of a 
database server can be found in the user guide for the installation of the Microsoft SQL 
Server. You can find this document in the ISD Wiki at Product Know-how > Documentation 
> HELiOS. 

 

To install the HELiOS Database Creator, click the corresponding button in the selection 
mask. The start mask of the setup wizard will be displayed.  
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Click Next to start the installation. 

 

Specify an installation directory for the HELiOS Database Creator, and click Next.  
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Click Install to start the installation.  
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Click Finish to complete the installation of the HELiOS Database Creator. If desired, you 
can now install further components via the selection mask. 

 

 Extensive information on the installation of the SQL Servers, the operation of the HELiOS 
Database Creator tool and the settting up of the ODBC connection on the clients can be found in the 
Wiki at Product Know-how > Documentation > HELiOS. 
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3 Procedure for Silent Installations 
The silent installation can, for example, be configured for HiCAD, for HELiOS 
Standalone or for the HiCAD Spooler. The procedure is always the same. 

3.1 Installation Settings 
To configure the installation options, start the installation setup.exe as usual and make 
the required settings. 

In the last dialogue of the installation, click on Extended Settings. 

 

Here you can configure in particular the settings for the User Configuration and the 
Catalogs in such a way that user interactions will no longer be required. 

» Execute parameter configuration: Via ISD standard template,  

» Execute CatalogueMaker/CatalogueUpdate: Deactivate Interactive button. 
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Procedure for Silent Installations 

   61 

Clicking Save creates a setup.ini file containing the desired settings. This file will be 
loaded automatically if it is located in the same directory as the Windows Installer 
package HiCAD.msi. Alternatively you can specify a file via the command line:  

setup.exe  SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

or 

msiexec  /i  HiCAD.msi SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

In this case the starting will not be “silent”, i.e. the installation dialogues wil appear, but 
with the default values of the .ini file. 

The option /l*v "<Log-Datei>" creates a log file of the installation which can be used for 
the diagnosis of installation problems.  

 

3.2 Redistributables 
Before distributing the installation you need to install the required redistributables on 
the target systems in order to circumvent the Microsoft-EULAs.  

Examples:  

vcredist.exe /passive 
 
dotNetFx40_Full_x86_x64.exe /passive 

The respective command line options of the individual Redistributable Installer can be 
called via the command line option /?.  

If required, the .msu files of the Windows Installer 4.5 can be installed with the 
Windows Package Manager pkgmgr.exe (http://support.microsoft.com/kb/934307/de). 

 

 You need to install the redistributables that are located on the DVD at Program32 or 
Program64 (except for the setup.exe and the language-specific folders such as de-de). 

 

http://support.microsoft.com/kb/934307/de
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3.3 Starting the Installation in the Silent Mode 
The installation can only be set to the silent mode via the command line: 

setup.exe  SETTINGS="<Ini-Datei>" /passive /l*v "<Log-Datei>" 

or 

msiexec.exe  /i HiCAD.msi /qb!- /SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

As neither dialogues nor error messages are displayed, /l*v "<Log-Datei>" creates a log 
file of the installation which can be used for the diagnosis of installation problems. 

Information on further command line options can be obtained via the command line, by 
means of the command msiexec /? , and via the Internet at 

http://technet.microsoft.com/de-de/library/ 
cc759262%28WS.10%29.aspx#BKMK_SetUI 
http://msdn.microsoft.com/en-us/library/windows/desktop/ 
aa372024%28v=vs.85%29.aspx 

 

3.4 Example of a Batch Installation incl. Redistributables and 
Log 

@set SOURCE=\\entw042\Setups\HiCAD 1900 
 
"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error 
"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei .NET Installation && goto error 
 
msiexec.exe /qb!- /i "%SOURCE%\de-de\HiCAD.msi" /l*v 
"%SOURCE%\logs\%COMPUTERNAME%_HiCADInstallLog.txt" 
SETTINGS="%SOURCE%\Config\setup.ini" 
@if errorlevel 1 echo Fehler bei HiCAD Installation && goto error 
@exit 
 
:error 
@echo Installationsfehler %errorlevel% 
@net helpmsg %errorlevel% 
@pause 

http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
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4 Important Notes on Configuration Management 
As of Version 1700, HiCAD enables a central configuration management with the 
Configuration Editor. This tool allows the creation of customer-specific configurations 
for a wide range of tasks, such as dimensoning, annotation, workshop drawing creation, 
fitting of vertical ladders etc. Once adjusted to company-specific requirements, these 
configurations can directly be used in HiCAD, without having to specify any further 
settings. The aim of our further developments is a gradual transfer of the previously 
used system files with their adjustable parameter settings into the Configuration Editor, 
thus enabling a central and safe configuration management. 

This transfer has already been realised for the following files:  

» ALGPAR.DAT (as of 1800.0) 

» BEMPAR.DAT (as of 1800.0) 

» DIMENSIONING_SETTINGS.XML (as of 1800.0) 

» KRPGEN.DAT (as of 1801.0) 

» MASPAR.DAT (ab 1801.0) 

» FITTABLE_SETTINGS.XML (as of 1801.0) 

» STBEMPAR.DAT (as of 1801.0) 

» TXTANSI.DAT (as of 1801.0) 

» STABMPAR.DAT (as of 1802.0)  

» AUBM3PAR.DAT (as of 1802.0) 

» ALG3DPAR.DAT (as of 1901.0) 

» FEATURE.DAT (as of 1901.0) 

» SCHRIF.DAT (as of 1901.0) 

» TXTFONT.DAT (as of 1901.0) 

» LINPAR.DAT (as of 1901.0) 
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» SSWRITESTEP.DAT (as of 1901.0) 

The settings from these files have been integrated into the Configuration Management. 
In the Online Help for the Configuration Management you will find the document 
Schluesselnamen.pdf, which shows you where you can retrieve the entries from the 
DAT files in the Configuration Editor.  

In addition, the Online Help provides a description of various scenarios for the utilisation 
of the tool.  An extensive description of the Configuration Management (Performance – 
Functions – Scenarios) is provided in the document ISD-Configuration.pdf. You can 
find this document 

» in the ISD Wiki at Product Know-how > Whitepaper 

» in the Docu\hicad sub-directory of your HiCAD installation sowie 

» on the start page of the Online Help at www.help.isdgroup.com 

 

4.1 The Configuration Management after Updates 
When performing an update from HiCAD 2012 or HiCAD 2013, your settings from the 
existing configuration file HICAD.CFGDB of your previous HiCAD version will be 
transferred to the Configuration Management of HiCAD 2014, namely into the 
Administrator profile. 

When the update is performed, only the values predefined by the ISD, i.e. the “factory 
settings”, will be changed. All other (administrator or user) settings will be preserved.  

If you use a central configuration database on a server, it will be automatically detected 
by the update program by means of the aforementioned Registry entry, and will be 
updated. For an update of several workstations, one single update will be sufficient; a 
multiple update will, however, not do any harm either (as an already updated setting will 
not be updated again).  

 

http://www.help.isdgroup.com/
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4.2 The Configuration Management after New Installations  
If you perform a (new) installation of HiCAD 2014, the settings predefined by the ISD 
will be initially used in the Administrator profile of the Configuration Management. If you 
want to transfer your individual settings in the file HICAD.CFGDB from HiCAD 2012 or 
HiCAD 2013 to the Configuration Management of HiCAD 2014, use the program 
CfgDbTool.exe in the HiCAD EXE sub-directory for this. 

Furthermore, you are enabled to transfer settings from old DAT and XML files which are 
now managed in the Configuration Editor, to the configuration database of the version 
2014. 

» Start the CfgDbTool.exe  from the HiCAD / exe sub-directory.  

 

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous 
configuration file (.CFDB) to the configuration file of version 2014.  

 

Installed database The configuration database to be updated, i.e. (the 
configuration database of your previous HiCAD version 
HiCAD-Version 2012/2013). 

Update source The configuration database of the new version; the 
configuration database with the current ISD settings can 
be found in the folder: [HiCAD installation 
directory]\Configuration.  



Important Notes on Configuration Management 

 66 UNLIMITED PERFORMANCE 

 

Update target The result of the update. If you enter the same file here as 
in the Installed database, a backup of the previous 
configuration database will be created. You cannot enter 
the same database here that you entered in the Update 
source field.  

» Select the directories. 

» Click the Update button to start the process. 

 

Use the Migrate tab to transfer your individual settings from old DAT and XML files 
which are now managed in the Configuration Editor, to the configuration database of the 
version 2014. 

The setting files with their adjustments need to be copied to the HiCAD SYS 
subdirectory of the new HiCAD version for this purpose.  

Start the CfgDbTool.exe  from the HiCAD / exe sub-directory and activate the Migrate 
tab.  

 

 

HiCAD base folder Here you enter the directory where your old DAT and XML files 
etc. are located. Please make sure that the old files have the 
same name and are located in the same directory structure as in 
a HiCAD standard installation. 
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Target database Here you specify the database to which the data are to be 
transferred.  

» Select the directories. 

» Click the Migrate button to start the process. 
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5 Important Notes on Updates 

 

 

5.1 Data Compatibility HiCAD/HELiOS 2014 (Version 190X) 
Please note that no changes are made to the HiCAD data format and the HELiOS 
standard database within major releases. This means that all patches and service packs 
of a version (e.g. 1900.x, 190X.x) will be using the same data format, and no HELiOS 
update will be required. 

 When updating from older HiCAD versions to version 190X, please note the 
information given below. Updates to version 2014 are only possible from version 2012 or 
2013.  

 

Update from version HELiOS-Update Changed HiCAD data format 

170X X  X 

180X X X 

» Please note: 

 If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have 
no access to the database any more. All workplaces need to be converted at the 
same time. 

 If the HiCAD data format has been changed, drawings and parts cannot be loaded 
with the older version if they were saved with the new version. 

Plant Engineering/Pipeline Planning 

If you have used the modules Plant Engineering and Pipeline Planning in a 
HiCAD version older than HiCAD 2014, please read the information given in the 
paragraph 5.8 “Important Notes on Plant Engineering and Pipeline Planning”. 
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5.2 Perform Installation 
The installation of version 2014 can be carried out by a technician of the ISD or by the 
customer.  

In this context, please note the following recommendations by the ISD:  

» HiCAD without HELiOS 

 Update of version 2012 or 2013 to version 2014: Can be carried out by 
experienced users with sufficient background knowledge.  

 Update of version 2011 (or older) to version 2014: An update is not possible. The 
update installation from version 2008 (or older) additionally included a data 
conversion from ANSI to UNICODE format. Please contact our Consulting team.  

» HiCAD with HELiOS 

 Update of version 2012 or 2013 to version 2014: An installation by the ISD is 
recommended. 

 Update of version 2011 (or older) to version 2014: An update is not possible. The 
update installation from version 2008 (or older) additionally included a data 
conversion from ANSI to UNICODE format. Please contact our Consulting team. 

» 3rd party CAD with HELiOS 

 Update of version 2012 or 2013 to 2014: An installation by the ISD is 
recommended. 
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5.3 Licensing 
Version 2014 can be obtained either on an installation medium (DVD), or via download 
from the ISD Homepage.  

The activation takes place via a software license. The activation is no longer linked to a 
dongle, but directly to the hardware of a server or an individual workstation. 

If you use a Server License, you need to update the License Server Software and the 
License Management Tools; if you use Local Licenses, you need to install the new 
version.  

Normally, licenses for older HiCAD/HELiOS versions must be revoked first.  

After confirmation of the revocation you will receive one or several Entitlement IDs 
enabling you, in combination with your E-Mail address and your Password, to activate 
the new licenses. (see 6.3) 

Licenses can be deactivated at any time, without having to contact the ISD Group, via 
the License Activator in the ISD License Manager, i.e. they can be temporarily stored on 
the Server of the ISD. For this you require your Entitlement ID, your E-mail address and 
your Password. The activation can then be performed on any other computer, i.e. the 
licenses can be transferred to this computer. For Server Licenses this procedure can 
only be performed for the entire license pool.  

 

 After updating HiCAD and HELiOS (Version 2008 or older) to Version 2012 or  2013, 
you must return your workstation dongle to the ISD. You can then no longer use any older 
HiCAD/HELiOS versions.  
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5.4 CatalogueMaker 
The CatalogueMaker is called automatically by the installation program in case of a new 
installation.  

It specifies which standard series is to be shown in the standard part catalogues (at the 
moment standard series are available for DIN, ISO, EN, ANSI and JIS). The selection of 
the standards in the CatalogueMaker influences the display of the standard parts only, 
not their availability. This will still be controlled by the license selection in the 
configuration menu. 

The existing configuration will be taken over automatically in case of an update; the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called in the ISD program group in the start menu via 
“Administration". 

 

5.5 Material Manager  
The Material Manager (materialmanager.exe) that enables a taking over of materials 
from Catalogue Editor to HELiOS needs to have the same database schema as HELiOS. 
Therefore the Material Manager will also be updated.  
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5.6 Computer / User Configuration 
A computer configuration for HiCAD settings can be activated in case of a new 
installation, respectively update. 

The “Workstation Parameter Configurator” can be started for a subsequent call by the 
Administrative Tools of the ISD program group. 

Depending on the selection in this window, the settings, saved in the corresponding 
CSV-file, will be configured. The default CSV-files can be found in the templates 
directory of the HiCAD installation. 

Important: 

» The settings files in the templates-directory will be overwritten without further queries 
in case of an update. 

» Company-specific CSV files can be filed in the sys-directory of the HiCAD installation; 
they can then be selected via the drop-down-list of the computer configuration. 

» Activate the HiCAD / HELiOS standard solution only when using the database 
supplied with HiCAD / HELiOS neXt 2007 or later. 

» When updating, the copying of standard masks must be activated only if no 
customized masks or BOMs are used. 
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5.7 *.KRP to *.KRA Conversion 
(only relevant for updates from HiCAD neXt 2005 or older) 

As of HiCAD neXt 2006, the HiCAD 3-D parts (*.KRP and related files) are combined in 
one archive (*.KRA). 

Before making the necessary conversion, you should save the directories, where the 
HiCAD 3-D parts have been saved (these are usually the paths given for the file groups 
C:, L: and M: in the FILEGRUP.DAT file; please check further adaptations). 

You need the SZN-SZA-Konvertierung.exe program once for the conversion. The 
program can be found in the \isdtools directory on the HiCAD installation CD. 

Copy the UpdateTools directory (with all files and sub directories) to the computer you 
want to use for the conversion. 

Start the SZN-SZA-Konvertierung.exe from this directory. The following window will be 
shown: 
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» Enter the UpdateTools directory as the directory of the HiCAD neXt installation. 

» Select the directory of the KRP files and the destination directory for the KRA files 
(these directories may be identical). 

» Activate the Convert all KRP files in given directory option and decide if KRPs, 
which are no longer used, are to be deleted in one step and if subdirectories are to 
be included in the conversion. 

The conversion of the given directory will be started after selecting the Execute button. 

If you need to convert KRP files into different directories, the previous steps need to be 
repeated accordingly. 

 

 We recommend the deletion of the KRP files, in particular when working without 
HELiOS, as they can still be loaded in HiCAD and can result in different states of KRP and 
KRA files. 

When using HELiOS functions, only KRA files are loaded, the change from KRP to KRA in the 
database is automatic during the database update with the help of the 
Helios2toHeliosNext.exe program. 
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5.8 Important Notes on Plant Engineering and Pipeline 
Planning 

If you have used the modules Plant Engineering and Pipeline Planning in a HiCAD 
version older than HiCAD 2014, please read the following information on how to 
proceed for an update  

Further adjustments may be required after the update installation, depending on the 
version from which you update, or which üarts you want to use. The corresponding 
information can be found in the Online Help at Plant Engineering > Important Notes on 
Updates. Alternativ stehen die Informationen auf als PDF-Datei im ISD Wiki unter 
Product Know how > Whitepaper zur Verfügung. 

 

5.8.1 Procedure for Plant Engineering Module 
 

1. Make a backup of the current state of your database. 

In the FILEGRUP.DAT file in the exe subdirectory of the existing old 
HiCAD version, check the entry at position 6:, which indicates the part directory 
for HiCAD Plant Engineering. This can either be the local directory PlantParts of 
your HiCAD installation (e.g. 6:C:\hicad\PlantParts), or a Server directory, e.g. 
6:\\MyServer\hicad\PlantParts.  

» If the Server directory has been entered here, make a backup of this Server 
directory. 

» If the local directory has been entered here, make a backup of this local  
PlantParts directory. 

2. Perform the HiCAD Update Installation.  

Please do not start the programs yet. 

3. Updating of the database  

» Start the Windows prompt and switch to the HiCAD exe directory.  

» Enter the command HeliosDbUpdate.exe /E. 

 If this has not already been done, update the database subversion. 



Important Notes on Updates 

 76 UNLIMITED PERFORMANCE 

 Open the Plant Engineering tab and click on Define links. 

 After completion of the process, close the program with Close. 

4. Edit part directory 

If a Server directory has been entered in the FILEGRUP.DAT file at position 6:, 
proceed as follows: 

» Copy the content of the local PlantParts directory of the HiCAD installation to 
this directory. 

» In the Server directory, delete the file _Upd_V170x.dat. 

If the local PlantParts directory has been entered in the FILEGRUP.DAT file at 
position 6:, proceed as follows: 

» In this directory, delete the file _Upd_V170x.dat.  

5. Check classes for updates from Versions older than HiCAD 2010  

If you are updating from a Version older than HiCAD 2010, and want to work 
with Air duct parts for the very first time, you need to check whether the classes 
listed below already exist in your database before continuing with Step 6. If this 
is the case, delete them. In all other cases you can continue with Step 6. 

 Base, rectangular 
 Offset bend, symmetrical 
 Offset bend, asymmetrical. 
 Flange, rectangular  
 Y-piece, rectangular 
 Duct part, rectangular 
 Knee, rectangular with arc 

 Knee, rectangular with corner  
 Pipe transition, symmetrical 
 Pipe transition, asymmetrical 
 T-piece, rectangular, straight top 
 T-piece, rectangular, slanted top 
 Transition, symmetrical 
 Transition, asymmetrical 
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6. Realise required database state 

Start the DbPlantDataImport.exe program. Login as Administrator, because you 
require unlimited read and write permissions. 

» If the Update part variants dialogue window appears, click Update now. 

 Again, log in as Administrator. 

 In the next dialogue, click Start. After completion of the process, click End. 

 If the DbPlantDataImport.exe program closes after this, re-start it. 

» Click Update Helios for Plant Engineering. 

» After completion of the process, close the program.  

7. Adjustment of part type "Gauge parts"  

 If required, you can now perform the adjustment for the part type "Gauge 
parts".
 

8. Import new variants 

Also use DbPlantDataImport.exe to import supplied (new) variants to your 
database if these are not yet contained in it. 

 

5.8.2 Adjustment for Part Type "Gauge Part" 
The old part type Gauge (Part type ID: 9800001) needs to be replaced with the new 
part type Gauge part (Part type ID: 5920010; Mask: sml_msrbtl.  

If this has not happened yet, proceed as follows: 

» The new part type with the ID 5920010 was automatically entered in the database by 
DbPlantDataImport.exe. 

» In the HELiOS Desktop, perform a part search with the Classification Gauge (not 
"Gauge part". 

 If this class does not exist, no further action will be required. 
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 If the class exists, mark all rows of the result list. Right-click to open the context 
menu, and select Classification. 

 

 
Ergebnisliste (Beispiel) 

 In the Classification tree structure tree, activate the new class Gauge parts: 

 

When you now click OK, all part masters belonging to the selected parts will be 
assigned the new class. 
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 Delete the now obsolete class Gauge after verifying that no parts are assigned to it 
any more: 

 

 

5.8.3 Procedure for Pipeline Planning Module 
 

1. Backup 

Before installing the HiCAD Update, check in the FILEGRUP.DAT file in the exe 
subdirectory of the existing old HiCAD version, check the entry at position 6:, 
which indicates the part directory for HiCAD Plant Engineering. This can either 
be the local directory PlantParts of your HiCAD installation (e.g. 
6:C:\hicad\PlantParts), or a Server directory, e.g. 6:\\MyServer\hicad\PlantParts.  

» If the Server directory has been entered here, make a backup of this Server 
directory. 

» If the local directory has been entered here, make a backup of this local  
PlantParts directory. 

2. Installation 

Perform the HiCAD-Update Installation.  

Do not start HiCAD yet.  
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3. Edit part directory 

If a Server directory has been entered in the FILEGRUP.DAT file at position 6:, 
proceed as follows: 

» Copy the content of the local PlantParts directory of the HiCAD installation to 
this directory. 

» In the Server directory, delete the file _Upd_V170x.dat. 

If the local PlantParts directory has been entered in the FILEGRUP.DAT file at 
position 6:, proceed as follows: 

» In this directory, delete the file _Upd_V170x.dat. 

4. Start HiCAD 

» Start HiCAD. Try to create a new Plant Engineering drawing file. 

» If the Update part variants dialogue appears, click Update now. 

» In the next dialogue, click Start. After completion of the process, click End. 

 

5.8.4 Adjustment of Parts and Database 
Please note:  

» Since HiCAD 2012 (Version 1700), HiCAD has been using a new data format. (see 
Data format) 

» If you have already created Plant Engineering parts with an older HiCAD version (i.e. 
before HiCAD 2014), you will normally want to use these parts in newer versions as 
well. If the parts exist in an old data format (< Version 1700), they need to be 
converted to the new format. (see Update of part data and database) 

» If you have not used any older HiCAD versions before, and HiCAD 2014 is your first 
HiCAD version, the part files already exist in the new archive file format. However, it 
may be possible that the installed HELIOS database needs to be adjusted. (see 
Adjustment of the database)  
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» The VarUpdate.exe program can only be started automatically from HiCAD if 
Catalogue has been set as the part data source. If you select Database as part data 
source, DbPlantDataImport.exe is used as the central update tool for Plant 
Engineering. This tool will in turn call the VarUpdate.exe program. (siehe 
VarUpdate.exe) 

 

Data format 

In older HiCAD versions (< 1700), a Plant Engineering part variant was represented by 
several files. Since HiCAD 2012 (Version 1700), only one file will exist for a Plant 
Engineering part variant – a so-called archive file (VAA), containing the files of all 
representation types in compressed form.  

A non-parameterised (fixed) part was, if several representation types were available, 
also represented by several files. As of HiCAD 2012, only one file will exist for fixed 
Plant Engineering part as well – an archive file (PAA), containing the files of all 
representation types in compressed form.  

 

Update of part data and database 

If you have already created Plant Engineering parts with an older HiCAD version (i.e. 
before HiCAD 2014), you will normally want to use these parts in newer versions as 
well. If the parts exist in an old data format (< Version 1700), they need to be converted 
to the new format. 

First make sure that the correct directory path to your current Plant Engineering files 
has been specified at position 6: in the FILEGRUP.DAT file in the HiCAD EXE 
subdirectory. 

The further procedure depends on whether you have selected the HELiOS Database or 
the HiCAD Catalogue as part data source (Settings > Settings > Part selection > Parts 
from: .... 
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Part data source: HELiOS Database 

Use the DbPlantDataImport.exe tool in the HiCAD EXE subdirectory to convert your part 
data, which also enables an update of the database for the plant Engineering module. 

If an updating of part data is required, HiCAD will display a corresponding dialogue 
when you try to create or open a Plant Engineering drawing file: 

 

If you are currently not using the HiCAD Plant Engineering modules, click OK and 
operate HiCAD in the same way as you would usually do. This window will not be re-
displayed until you re-start HiCAD. 

But if you want to use the HiCAD Plant Engineering modules, click OK, and then update 
your part data first, using the DBPlantDataImport.exe tool. 
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Part data source auteildatenquelle: HiCAD Catalogue-Katalog 

If an updating of part data is required, HiCAD will display a corresponding dialogue 
when you try to create or open a Plant Engineering drawing file: 

 

If you are currently not using the HiCAD Plant Engineering modules, click Update later 
and operate HiCAD in the same way as you would usually do. This window will not be 
re-displayed until you re-start HiCAD. 

If you want to use the HiCAD Plant Engineering modules, click Update now. This starts 
the VarUpdate.exe tool for the updating of your database. The following window will be 
displayed:  
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Part data for which a catalogue entry exists are highlighted. Click Start: The updating of 
the part data begins. This process normally takes 10 - 20 minutes, depending on the 
number of existing part files; if the parts are transferred via a network, the process can 
take significantly longer. The update was successful if an archive file could be 
generated for all parts for which a part master (or catalogue entry if the Catalogue has 
been selected as part data source) exists. If possible, an archive file will be created for 
all other parts as well. If the update was not successful, an error log will be displayed, 
indicating for each part whether an archive file could be successfully generated. 

After the update, click End and re-start HiCAD. Your part inventory can now be used in 
HiCAD Plant Engineering. 
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Adjustment of the database 

If you did not use any old HiCAD versions and install the new HiCAD version on your 
computer, the part files already exist in the new archive file format. However, it may be 
possible that the installed HELIOS database needs to be adjusted. Use the 
DbPlantDataImport.exe tool in the HiCAD EXE subdirectory for this purpose. 

If an updating of the database is required, HiCAD will display a corresponding dialogue 
when you try to create or open a Plant Engineering drawing file: 

 

If you are currently not using the HiCAD Plant Engineering modules, click OK and 
operate HiCAD in the same way as you would usually do. This window will not be re-
displayed until you re-start HiCAD. 

But if you want to use the HiCAD Plant Engineering modules, click OK, and then close 
HiCAD. After this, update your database. 
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VarUpdate.exe 

You use this tool for the conversion of part files to archive file format (file extension: .paa 
or .vaa). In contrast to older HiCAD versions, it can only be started automatically from 
HiCAD if Catalogue has been set as the part data source (Settings > Settings > Part 
selection > Parts from: Catalogue). If you select Database as part data source, 
DbPlantDataImport.exe is used as the central update tool for Plant Engineering. This 
tool will in turn call the VarUpdate.exe program. 

The links that were previously defined by VarUpdate.exe, as well as all other required 
links will now be set up by DbPlantDataImport.exe. 

 

5.9 Update Training 
ISD now offers a 2-day Update Training for new versions. Further information on 
training dates can be found on the attached form or our website: www.isdgroup.com / 
Support / Training. 

http://www.isdgroup.com/
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6 Licensing  
HiCAD/HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 In the HiCAD directory DOCU you can find an Online Help for the Licence Manager. 
You start the Help by calling the LICENSEMANAGER.HTML file in the folder 
Docu\tools\Licensemanager.  
 

 In the ISD Wiki you can find the PDF document Use Case: Checkout Licenses at Product Know-
how > Whitepaper. 

 

6.1 General Information about Licensing 

6.1.1 Local (Workstation-Specific) Licensing 
If you choose local licensing, the activation will be directly locked to the hardware of the 
workstation on which your HiCAD and HELiOS Desktop program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses 
(standalone).  This ID will be required for the activation and deactivation of the licenses 
and software modules. Please keep the Entitlement ID! Without this ID you cannot 
activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  After installing HiCAD/HELiOS, you activate the 
licenses by means of the License Activator in the ISD License Manager. 

 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
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6.1.2 Network (Server-Controlled) Licensing 
If you choose network (server-controlled) licensing, the license will be directly locked to 
the hardware of the server that centrally manages the HiCAD/HELiOS licenses. These 
licenses can be used on any workstation in your network that is connected to this 
server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several 
network servers, e.g. at several locations, you will receive one Entitlement ID for each 
network server. This ID will be required for the activation and deactivation of the 
licenses and software modules. Please keep the Entitlement ID! Without this ID you 
cannot activate or deactivate any licenses! In case of a defect, no reconstruction of 
licenses will be possible without the Entitlement ID!  You activate/deactivate the network 
licenses by means of the License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation 
within or outside the network (so-called “commuter licenses”). This enables you to 
continue working at a different location, without being connected to the license server 
(unless your HiCAD/HELiOS installation requires a connection to a database server).  
For this purpose you define a specific period during which you want the license to be 
available on a selected workstation. For this period, this license will be blocked on the 
license server. After expiry of this period, the license will be made available on the 
license server again. It is also possible to manually return this license to the server 
before expiry of the defined period, if the workstation is connected to the server. 
Licenses for one workstation can be checked out for at least one day, with the counting 
beginning at 1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses 
first. 

 

 A static IP address is required for correct operation of the license server! 
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6.1.3 Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday 
morning (11.00 am) you suddenly need to see a customer for design tasks, and you 
know that you will still be on-site at the customer’s facility on Tuesday. You therefore 
check out a license for 24 hours on 11.00 am. This means that you can use this 
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration 
of this period, the license is automatically made available again on the server. If you 
manage to finish your work on Tuesday at midday, you can go back to your office 
and return the license to the server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in 
your office on Monday, 11.00 am. In such cases you can generate a hardware ID, 
enabling your colleagues in the office to check out a license for you. This license is 
sent to you by E-mail and can then be activated. In contrast to the previous example, 
this license is exclusively available to you for a fixed period of time and cannot be 
returned to the server before expiration of this period.  

If you activate a license while the WLAN card is switched on, this license will only be 
valid and visible when the WLAN card is switched on. If, however, the license is 
activated while the WLAN card is switched off, the license will always be valid, no matter 
whether the WLAN card is switched on or off.  

 

 The PDF document Use case: Check out licenses provides further information on this topic. The 
document can be found in the ISD Wiki at Product Know-how > Whitepaper. 
 

 In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF document Use case: 
Checkout Licenses. 

 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
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6.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a 
computer without HiCAD/HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps 
track of all the licenses and handles requests from network users who want to run a 
HiCAD/HELiOS application, granting authorization to the requesters, or denying 
requests if all licenses are in use.  

The license server must not be installed on the same computer on which an ISD 
software product (HiCAD, HELiOS) is installed, as both product share system data 
concerning the licensing information. Formerly, such parallel installations of license 
servers and ISD products were performed in cases where a customer occasionally 
wanted to transfer the license to another computer (Remote Commuter License). As of 
Version 1700 such scenarios can be realised in a much more convenient manner with a 
new licensing procedure.  

 

 Please note:  

 As of Version 1700, parallel installations of license servers and ISD products (i.e. on 
the same computer) are no longer covered by the warranty. The ISD group advises 
you strongly not to perform such installations.   

 A static IP address is required for a correct operation of the License Server! 

 

 



Licensing 

   91 
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6.2.1 Server Installation 
The SafeNet License Server is installed from the HiCAD DVD. Start Windows. If 
Windows is already open, close all other applications. Insert the DVD in the DVD drive. 
The installation wizard will be started automatically. In the installation wizard, click the 
Standard Edition button, which opens a mask with various selection options for software 
components.   

 

 If you want to perform a HiCAD update to Version 2014 and use a license server (i.e. 
work with network licenses), you require Version 8.5.0.1400 of the SafeNet License Server. 
If you have installed an older version, you need to uninstall it before re-installing the 
SafeNet License Server. 
 

 

 

Click the SafeNet License Server button to start the installation.  
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After successful installation you will find the Server (Sentinel RMS License Manager) 
under Services. From here you can also start and end the License Server.  
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6.2.2 Client Configuration 
To ensure that the HiCAD/HELiOS Client finds the correct License Server, an 
environment variable LSFORCEHOST should be set on each Client using network 
licenses. The value HOSTNAME, respectively the IP address of the License Server is 
assigned to the variable. 
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6.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager 2.0 the communication between the 
customer and the ISD could be facilitated significantly.  

 

6.3.1 AutoRequest Licenses  
When acquiring a HiCAD/HELiOS license, you will obtain one Entitlement ID for local 
licenses (Standalone) and another one for network licenses (Network). If you have 
several network servers, e.g. at different locations, you will obtain one Entitlement ID for 
each network server. These numbers will be required for the activation and deactivation 
of the licenses and the software modules.   

 

 Please keep the Entitlement ID! Without this number you cannot activate or 
deactivate licenses. In case of a system crash a reconstruction of the licenses cannot take 
place without the Entitlement ID! 
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After installing HiCAD/HELiOS you can find the program in the Windows Start menu at 
ISD Software und Systeme > Administration. Please note that for the execution of 
some functions, administrator rights are required.  

The range of functions of the ISD License Manager depends on the activation of the 
License Administration Tools option. The information about this setting is entered in the 
Registry and can also be changed there subsequently if desired (please contact the 
Hotline).   
 

 To activate/deactivate Network Licenses, always start the ISD License Manager via 
the Windows Start menu: Select Start > All programs > ISD Software und Systeme GmbH > 
Administration. To avoid errors when activating/deactivating licenses, perform an update of 
the new ISD License Manager and/or the License Administration Tools beforehand. 

 

Activate the License Activator tab and enter the Entitlement ID, your E-mail address 
and your Password. New customers obtain their password from the ISD Hotline. With 
this password you can also access the Download Area.  

 

After entering the data, click Login. The ISD License Manager 2.0 connects to the ISD 
License Server and the acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 
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6.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired 
licenses are indicated next to each module. Select the modules to be activated and click 
Activate to start the activation.  

For Server Licenses the modules are already pre-selected! 

 

After successful activation a message showing you that all licenses have been 
successfully activated will be displayed:  

 

You can then log out and start working with the HiCAD/HELiOS modules. 

In addition, you will receive an E-mail informing you about the deactivated modules.  

For Network Licenses, all modules will always be activated or deactivated (for further 
information about the operation of the License Manager, please read the Online Help for 
the License Manager. 
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6.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows 7 to Windows 8)  
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID 
need to be deactivated completely before a redistribution of the module licenses can 
take place. 

After starting the ISD License Manager 2.0 the activated modules will be highlighted in a 
different colour. Click the Deactivate button to revoke the activation of the modules.  

 

A selection is not possible, as you need to deactivate all modules, no matter whether 
local licenses or network licenses.  
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 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD License Manager 
2.0! 
 

After successful deactivation the following message will be displayed:  

 

 

6.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all 
trial licenses with a limited period of validity, all purchasable licenses which are not 
simultaneously available as trail licenses.  

 

6.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted 
connection or an accidental deletion of licenses, restore all licenses by logging in with 
your Entitlement ID. The restoring will only function if the hardware was not changed 
(see 4.2.3.3 Deactivate Licenses). 

 

6.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card is either 
always switched on, or always switched off.  
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6.3.7 Floating Licenses 
If you have acquired a HiCAD Extension Module with the property Floating-able at 
runtime, you can activate/deactivate them during the current HiCAD session. The 
HiCAD Selection dialogue window will be displayed. 

 

If one Extension Module is (de)activated, the Extension Modules that are prerequisites 
for this module will also be (de)activated (if they are also floating-able at runtime).  
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6.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not 
connected to the Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

6.4.1 Direct Checkout from License Server 
Start the ISD License Manager application (while a connection to the Server still exists). 
Switch to the Commuter License tab.  

 

If you have set the system environment variable LSFORCEHOST, the entered License 
Server is displayed at start-up as pre-selection. Use the Search network button to 
automatically search for License Servers.  
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Expand the tree structure of the found Server by a click on the “+”-sign. The result 
looks as follows:  

 

Select the required licenses by activating the corresponding checkboxes on the left 
hand side. On the right hand side, information on the selected license is displayed.  

In the Commuter license: Validity in days field, you enter the number of days that you 
want the commuter licenses to remain checked out from the Server. The maximum 
number of days is 60. By default (or if a “0” is entered), the value is set to 1.  

 

 For reasons of safety you should check out the licenses only for the required period! 
If a commuter license is lost, e.g. because of theft or a defect of the client computer, the 
license on the Server cannot be used any more before expiry of this date! 
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After entering the expiry date for the commuter licenses, activate the Update licenses 
button. 
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Commuter licenses are checked out from the Server. 

 

All selected licenses are now checked out from the Server and you possess all rights on 
your computer for the specified validity period for the commuter licenses. This means 
that you are enabled to work network-independent. The checked out licenses are no 
longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, 
you need to connect to the Server, deactivate the checkboxes on the left and click the 
Update licenses button. All licenses are now made available on the Server and locked 
on your computer, i.e. you can now only use HiCAD/HELiOS if there is a connection to 
the License Server. The licenses made available again can now also be used from other 
workstations. 
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6.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing 
network connection.  

 

 Please note that administrator rights are required.  
Commuter licenses checked out in this way cannot be returned to the License Server! This 
means that the commuter licenses that have been checked out from the Server are only 
(automatically) made available again after their expiry date. 

 

Several steps are required for this, by the administrator having a network connection to 
the License Server, as well as by the Client having no network connection to the License 
Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code 
tab and sends the generated character set to the administrator (via E-mail or over the 
phone). 
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The administrator starts the ISD License Manager and switches to the Commuter 
License tab. The License Server is selected, and the required licenses (modules) are 
activated in the left window. To checkout a remote commuter license the administrator 
now needs to activate the Check out authorisation for remote computer checkbox. 

 

A click on the Update licenses button opens a new dialogue window, in which the 
administrator enters the character set received from the Client.  
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After selecting OK, another dialogue opens, in which you enter the target path and the 
file name for the licenses to be swapped out.  

 

Select OK to check out the commuter licenses from the License Server and swap them 
out to a file, e.g. RemoteLicCode.lic. 
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The successful checkout will be confirmed. The administrator then sends the file, 
RemoteLicCode.lic, to the Client.  

After receiving the file with the commuter licenses, the Client starts the ISD License 
Manager again and activates the Install Remote Authorisation Code tab. Here the 
received commuter licenses can be installed directly via file selection or via copying of 
the file contents.  

 

Click the Install... button to install the commuter licenses on the Client.  
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After successful installation, switch to the License Info tab. Press the F5 (Update) key 
on your keyboard. You are now informed which licenses are installed locally on the 
computer.  
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6.5 License Configuration 
Some cases may require the use of only certain specific licences on a computer. 
Example: On the License Server, HiCAD creator and HiCAD solution licences are 
available. On one Client, HiCAD is to be started with a HiCAD creator license, on 
another Client, HiCAD is to be started with a HiCAD solution licence. If the selected 
license is no longer available, an application start is no longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which 
also the Commuter Licenses belong), it is mandatory to make a pre-configuration and save 
it as workstation configuration.  
 

If no pre-configuration is possible, the HiCAD/HELiOS configuration tab will be 
displayed before the start of HiCAD/HELiOS. If the selected configuration does not 
match the available licenses, a warning message will be issued, with a list of available 
licenses. After this, the configuration selection will be displayed again. 
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6.5.1 License Configuration HiCAD 

 

 

On the HiCAD Configuration tab of the ISD License Manager tool you have the option 
to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HiCAD is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HiCAD is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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6.5.2 License Configuration HELiOS 

 

On the HELiOS Configuration tab of the ISD License Manager tool you have the option 
to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HELIOS is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HELiOS is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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6.6 Important Softlock/Hardlock Information 
When using the softlock/hardlocks as selector for the license file, please note that for 
system-inherent reasons the date must not be reset! Such resetting causes a blocking of 
the softlock/hardlock that can only be revoked by the ISD by means of a re-
programming. In such cases, we would have to charge you the costs of this 
unnecessary additional work. 

A change of the system time is possible, as long as it is not date-comprehensive. 

If you deem such date conversion absolutely necessary, please inform our staff on the 
hotline in good time. 

 

ISD Software und Systeme GmbH 

Phone: 0049 - 231 / 97 93 - 166 

Fax: 0049 - 231 / 97 93 - 101 

Mailto: hotline@isdgroup.de 

 

 IMPORTANT:  If you have a 64Bit version of HiCAD/HELiOS, the hardlock can no longer 
be used as a license file selector due to missing driver support! 
 

mailto:hotline@isdgroup.de
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6.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HiCAD/HELiOS workstations 
against theft. If desired, we can tell you the reinstatement value of your software. If a 
workstation is stolen, you will need a new license. In such cases, please send us the 
police report of the theft first. We will then provide you with a license for a limited period 
of time, and submit an offer for a new license to you. The ISD will send you the new 
license after clarification of the case with your insurance and receipt of your payment for 
the license fee. 
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7 HiCAD at a Glance 
HiCAD is a universal CAD system with true 2-D/3-D associativity, innovative functions, 
comprehensive industry solutions and an integrated PDM component. Up-to-date 
working techniques and numerous automatisms help you abridge routine tasks. 
Simulation and analysis tools enable you to detect and prevent possible collisions within 
your product models at early design stages.  

» Performance characteristics:  

 Microsoft Windows standard and GUI based on the Windows “Ribbons” 
technology 

 Combined working in 2-D and 3-D  

 Assembly-oriented design engineering providing top performance even for very 
large assemblies  

 Transparency and clearness thanks to convenient search functions, filters and 
multiple selection options  

 Extensive symbol and standard part catalogues 

 Simulation and analysis tools  

 Standardisation and automation 

 Direct modelling and parametric design 

 Integrated product data management with HELiOS  

 Data transfer from other systems (CATIA, ME10, STEP, DXF, DWG etc.)  

 BOM-creation, PPS interface, transfer to NC programs  

 Comprehensive industry solutions for Steel/Metal Engineering, Plant Engineering, 
Sheet Metal processing and Plant Engineering 

 Individually extendable due to a modular structure  
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8 First Steps in HiCAD 
8.1 Start HiCAD 
You start HiCAD by:  

» using the Windows task bar (Start) to choose the Programs folder and then clicking 

the HiCAD icon  in the ISD … menu, or   

» by clicking the HiCAD icon  on your desktop.  

Once you have started HiCAD, the input window for License Management is initially 
displayed, followed by the HiCAD Start Centre (provided that it has not been 
deactivated).  

 During the launch of HiCAD it is checked whether the required version of .NET 
Framework is actually installed. If this is not the case, an appropriate error message is 
issued and HiCAD is closed. 

 

8.2 DLL Check  
Due to entries in the Windows-Registry, more and more libraries from third parties (DLL 
file) are integrated when HiCAD is launched, e.g. in order to capture messages or 
outputs to the screen. Some examples are 

» Virus scanners, 

» PDF programs,  

» Programs for the recording of screen activities,  

etc. These files can sometimes cause problems.  
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When you start HiCAD, it will first be checked whether DLL files are assigned to the 
Registry value AppInit in the Registry key  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Windows (64Bit) 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 
NT\CurrentVersion\Windows (32Bit) 

If this is the case, the following message will be displayed: 

 

Activate the Suppress message checkbox if you do not want this message to be 
displayed upon future HiCAD starts. Also inform your administrator about the message. 
The message will not reappear until the Registry value changes again, i.e. not until other 
DLLs will be loaded!  

If you want to suppress the message completely, set the Registry value Check for 
AppInit_DLLs in the Registry key  

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD2014\HiCAD 
2014 

to 0. 

 Be careful when editing the Registry! The entering of incorrect values or the 
deleting of values can destablilize the operating system! 
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8.3 Close HiCAD 
To close HiCAD,  

» click the Close icon  or 

» click the ISD button and select End.  

If any HiCAD drawings are still open at this point, you can to save them.  

 If you activate the Clear temporary directory? checkbox when closing HiCAD, all 
automatically created data backups will be deleted. 
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8.4 The Start Centre 
When you start HiCAD for the first time, the Start Centre is displayed, which has been 
designed to facilitate your first steps of drawing creation.  

 

Please note:  

» Click on the graphic to obtain information about the version number.  

» When you call the Start Centre again, the values that you set last will be displayed as 
default values.  

» The settings you have selected for the Create new drawing start action will even be 
used in HiCAD if you call the New drawing (without DB) function. 
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8.4.1 Create New Drawing 
If you want to create a new drawing, specify whether you want to create a part drawing 
or an assembly drawing by activating the appropriate checkbox.  

» Part drawing (detail drawing)   
In a part drawing (detail drawing) you divide your drawing into main parts and sub-
parts. To define the part structure you use so-called dummy parts which symbolise 
the assembly. You then assign assembly-relevant main parts and sub-parts to these 
dummy parts. Instead of dummy parts you may as well use the special component 
type Assembly.  

» Assembly drawing   
You can define 3-D drawings directly when creating the assembly drawing and - if 
you are working in parallel with HELiOS - enter them into the database. This provides 
significantly more efficiency, particularly for referencing, itemisation and BOM-
creation.  

 

8.4.2 Options 

» Enter drawing into database  
If you are working with HELiOS you can define here whether you want to the new 
drawing to be entered into the database. If you activate this checkbox, HiCAD will 
prompt you to specify the document master data once you exit the Start Centre. If 
not, you will be prompted to enter the name of the drawing file.  
Activate, if desired, the project to which you want to assign the drawing.  

» Scale  
Here you can preset the scale of the drawing.   

» Start mode  
Here, choose the start mode you want to be activated once you exit the Start Centre, 
e.g. 2-D, if you want to start the drawing in 2-D or 3-D Extruded solid, if you want to 
start your drawing by creating an extruded solid in 3-D.  

» Create processing planes (3-D only)  
Here you can specify which of the standard processing planes you want to create. 
Activate the appropriate checkbox.   
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» View projection and View representation (3-D only)  
If you want to work in 3-D, use these functions to pre-set the model view and the 
view representation.  

 

8.4.3 Load Existing Drawing 
If you have chosen Load existing drawing as start mode, you can specify whether you 
want to load the drawing via the database, the Explorer or via an interface. As with a 
new creation, you may also activate the project directly. 

 

8.4.4 Switch Start Centre Display Off 
If you activate the Switch Start Centre display off checkbox and click OK to exit the 
Start centre, the current settings will apply as the default settings for whenever you start 
HICAD again and create new drawings. The Start Centre is then no longer displayed. To 
re-activate the Start Centre display and to change the settings, choose the Activate Start 
Centre function. The changed settings will be applied when starting HiCAD again.  

If you click OK to exit the Start Centre, the current settings are used as the default 
setting if, on the other hand, you exit the Start Centre by pressing the ESC key or the  
icon, the settings are ignored.  
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9 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product 
quality can only be optimised if all departments of a company work together efficiently. 
This requires a well-structured and efficient exchange of information between the 
parties involved in the production process - from Manufacturing, Purchasing and 
Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-
free gathering, distribution and management of the data that is required for the process 
chain. Once saved, these data can be re-used within the entire company and for the 
complete product life cycle. HELiOS manages and controls all process cycles by 
regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be 
avoided and error sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single 
system, thus making HELiOS the knowledge reservoir of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, 
the so-called HELiOS Desktop. 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific 
requirements.  
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10 First Steps in HELiOS 
10.1 Program Call 
Start the HELiOS Desktop by double-clicking the HELiOS.EXE file in the \HiCAD\exe 

directory or via the program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the 
right-hand window will not be shown when you start HELiOS Desktop for the first time. 
Select a project first and display the list view via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an 
error message from the Vault Server.  

 

10.2 Registration 
The HELiOS User Management is based on the User Management of Windows. If 
several users are registered with the same Windows User Name in EDBSETUP, a login 
mask will appear when starting HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User 
Management.  

If you select a project from the Active Project drop-down list, this project will be opened 
after starting HELiOS Desktop. If you select the project-independent setting, all 
documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need 
to specify a Start Project. On the Ribbon, activate the Tools tab, then select Options, 
activate in the dialogue the General tab and choose a start project. 

 

mk:@MSITStore:D:/Dokumente%20und%20Einstellungen/sduempelmann.INT/Desktop/helios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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10.3 Login 
Use the Login  function for a new login while working with the HELiOS Desktop, e.g. 
to work with different rights without having to exit the program. 

» Activate the Login  function on the QuickAccess toolbar. 

» Select a different user.   

» If required, change the active project and confirm the new settings with Login.  
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11 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all 
functions and techniques which are available in HiCAD – from 2-D and 3-D to the 
integrated PDM functionality, Sheet Metal Processing to Steel/Metal and Plant 
Engineering.  

 Please note that the scope of available functions may vary, depending on the 
configuration level of your HiCAD product. This means that some of the functions described 
in the Online Help may not be available. 
 
Since Version 2012, the Help has been available both locally (status of the installation 
DVD) and on the Internet (regularly updated) at help.isdgroup.com. Both versions of the 
Help can be called from HiCAD via the Help Topics and Information item (“?” icon on 
the top right of window). You can select your preferred Online Help type via ? > Help 
Settings.   
 

 
 

You call the HELiOS Help via the HELiOS Desktop Help menu item.  
 

 
 
To be able to use the Internet version of the Help, you need to register for the ISD’s new 
company Wiki once. This will not only give you access to the new Help, but also provide 
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you with many other information which will be made available shortly in the ISD Wiki 
(Forum, Download area etc.). 
 
Click Sign up in the login window of the Online Help to register. If you have already 
been registered, enter your access data and click Login to get directly to the start page 
of the Online Help.  
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Register for the ISD Wiki 
 
After clicking Sign up in the Login window of the Online Help, enter the data required 
for the ISD Wiki in the dialogue window. Confirm the security prompt and click the Sign 
up button. 
 

 
 
After the registration the dashboard of the ISD Wiki will be displayed. A message 
indicates whether you have been authenticated as an ISD customer.  
 
If you could be identified as an ISD customer, you can now directly launch the Online 
Help using your registration data.  
 
If you could not be identified as an ISD customer, please perform the steps described in 
the message.  
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12 What’s New in Version 2014? 
The following chapter provides you with an overview of changes, new features and 
enhancements in HiCAD 2014. Extensive information about them can be found in the 
“What’s New?” pages of the Online Help. 

 

12.1 New in Service Pack 2 
12.1.1 Module-comprehensive News 

» Enhanced Design Checker (SP2) 
e.g. d etection of BOM-relevant parts without item number, checkingo f Maximum 
length and weight of assemblies, Maximum dimensions and weight of assemblies in 
Steel Engineering 

» Novice configuration/Start configuration - Automatically determine 
assembly/processed part (SP2) 
In the Novice configuration as well as in the Configuration Editor, the Automatically 
determine assembly/processed part parameter is no longer available  

» Total number of drawing sheets in title block (SP2) 
Besides the sheet number and the scale of the drawing you can now also enter the 
total number of the sheets (Sheet areas) in the title block of the drawing frame, with 
the help of the %BLATTANZAHL key. 

» Form assembly (SP2) 
The Form assembly function can now also be applied to several assemblies.  

» Surface approximation - Warning message (SP2) 
If a value of > 10 is selected for the number of Polygon points per quadrant or the 
Via distance tolerance with minimum/maximum number value of the Surface 
approximation  function, this may cause a performance decrease. HiCAD will 
therefore issue a warning massage.  

» Selectable number of data backups (SP2) 
The number of the data backups (min. 2, max. 5) can be set in the Configuration 
Editor.  
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» Parts4cad - New buttons in dialogue window (SP2) 
Two new buttons are available in the dialogue window of the parts4cad  function – 
Reset catalogue list to supplied state and Download current catalogue list from 
Cadenas Server. 

» Visual effects - Apply texture settings (SP2) 
This function in the Visual effects docking window enables you to apply the texture 
settings of one part to another part.  

» Radial pin calculation (SP2) 
Use this function to check whether a radial pin that was inserted for the connection 
of a shaft and a hub has the required stability.  

» New point option - Vertex of ellipsellipsenscheitelpunkt (SP2) 
Use the new Vertex of ellipse  point option to select the vertices of the nearest 2-D/3-
D ellipse.  

» Änderung der Markierungsfarben (SP2) 
The predefined colour settings for the different marking colours have been changed. 

» Optimised operation of Space Mouse (SP2) 

» Search function with display of found and selected parts (SP2) 
 

 

12.1.2 2-D 

» 2D-Schnittstelle (SP2)  
When reading DXF, DWG or MI files into HiCAD 2-D, colours outside the HiCAD 
colour palette (System colours < 40) will be distributed among unused system 
colours.  

» Document master / project attributes in annotation tags (SP2) 
Besides HELiOS part master attributes you can now also select HELiOS document 
master attributes and project attributes directly from the right listbox in the 
Annotation Editor. Document master attributes are preceded by the string %DBAD, 
project attributes are preceded by the string %DBAP.  

 



What’s New in Version 2014? 

   133 

12.1.3 3-D 

» Performance (SP2) 
The shading of facets with many holes - e.g. perforated plates with several thousands 
of holes - has been accelerated significantly. Thanks to internal optimisations the 
deletion of objects - especially in large drawings with very many annotation tags - has 
been speeded up significantly. 

» Simplify 3-D models/ Envelope parts (SP2) 
The new Simplify tab contains all functions that enable a simplification of complex 3-
D models before passing them on to any third party. Particular mention here 
deserves the Envelope parts function. This function enables you to protect precious 
drawings and generate simple models rapidly. Simplified representations without 
internal structures can be created at the push of a button. Such "envelopes" are 
solids that can be processed further in the target system. At the same time, the use 
of envelopes reduces the amount of data significantly. 

» Revised dialogue window for powder marking lines (SP2) 

» Change edge colour for part lists (SP2) 
Edge colours can now be changed in one step for entire part lists.  

» Views with links - Undo transformation (SP2)  
When you move a master view, all views linked to this master view will be moved as 
well. If you undo the transformation of the master view with the Undo last view 
transformation function, this action will also affect the linked views. 

» Processing plane perpendicular to arc (SP2)  
The behaviour of the New- Perpendicular to edge function has been changed for 
arcs. Previously, the automatically detected Z-axis was located between the end 
points of the arc when the arc was selected. This behaviour does, however, not 
correspond to the behaviour one would encounter in practice, and was therefore 
changed. 

» Show view frame when selecting view in ICN (SP2) 
If you click the name of a view in the Views tab of the ICN, the corresponding view  
will be activated and indicated by means of a dotted frame in the drawing area. The 
frame will disappear as soon as you move the cursor from the ICN into the drawing 
area. 
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» Clone + Move, via Parametric grid: Changed behaviour (SP2) 
If the original part has no feature log, if you have chosen the Union fitting mode and 
have activated the Feature checkbox, a "Create body" feature will be subsequently 
created for the original part. 

» Changed default setting for weld seams (SP2) 
The default setting for the Weld seam type in the Configuration Editor has been 
changed to Fillet weld. The Butt weld type is no longer available.  

» Assembly attributes: Fix weight (SP2) 
The attribute mask for assemblies has been extended. As with 3-D parts and Sheet 
Metal parts, you can now also fix the weight for assemblies. This makes sense if you 
import files via the STEP interface - for example, a motor consisting of several parts.  

» Preview image for feature variant creation (SP2) 
When creating a feature variant a graphical preview for the Variant Editor will also be 
automatically created for shaded views. 

» Revised context menu for 3-D parts (SP2) 
The context menu for 3-D parts has been restructured. 

» Clone + Move, via to 3-D points - Behaviour for part lists (SP2) 
If a part list is active when you call the function, the function will not be ended after 
creation of the copy, but can be applied to this part list once more. Previously this 
was only possible for the active part. 

» Referencing without database (SP2) 
In the Configuration Editor you will find the new Automatic name selection for 
referenced parts without database entry checkbox. This setting is relevant for the 
saving of referenced parts without database entry - e.g. for the creation of solid 
primitives, extruded or revolved parts while the Referenced checkbox is active. 

» Form assembly - also for assemblies (SP2) 
The Form assembly function can also be applied to assemblies.  

» Assembly attributes: Additional tolerances acc. to DIN EN 1090 (SP2) 
In the attribute mask for assemblies you can find the Additional tolerances field, if 
your HiCAD product includes a Steel Engineering License. This field, where you can 
select additional tolerances according to DIN EN 1090 is important if you want to 
create weld seam test protocols. Default setting is Class 1 (EN 1090).  
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» Sketches - Fillet non-continuous polylines (SP2) 
Non-continuous polylines of a sketch, too, can be selected with one mouse click to 
be filleted.  

» Sketches - Revised approximation functionality (SP2) 
The previous functions Approximation and Approximation, Settings have been 
combined into one function with the name Replace lines with straight lines or circular 
arcs. Furthermore, algorithms and dialogues have been optimised. 

» Document master/Project attributes in annotations (SP2) 
Besides HELiOS part master attributes you can now also select HELiOS document 
master attributes and project attributes directly in the Annotation Editor.  

» Management of manually assigned item numbers (SP2) 
If you assign item number manually, e.g. with the Part attributes  function, the 
corresponding parts will now be marked as "manually itemised". During automatic 
itemisation HiCAD will search for manually itemised parts or assemblies and checks 
whether they cause any conflicts - e.g. for identical part search.  

» Dished ends now with feature (SP2) 
When you insert dished ends in your drawing, a corresponding feature will be 
created. 

» Visual effects - Apply texture settings (SP2) 
In the Textures tab of the Visual effects docking window you will now find the new 
Copy texture settings from part function. This function enables you to apply the 
texture settings of one part to another part.  

» Hatching in sectional view and cut-out - Take settings over from part (SP2) 
The Hatch section + cut-out dialogue window contains the new Apply from part 
option. Click this button to apply the settings of an existing part, i.e. the settings that 
you assigned to the part using the Hatch section + cut-out function, to the dialogue 
window.  

» Simulation - Simulation: Conveyors (SP2) 
Besides motors, you can also use conveyors for physical simulations. The conveyor 
moves all parts of an assembly in a defined direction, along a defined surface, and 
with a specified speed. The movement continues until the parts lose contact with the 
defined surface.  
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» Simulation: Sequences of views (SP2) 
Use the new View control  entry in the Simulation tree to define sequences of views in 
the simulation: You select a sequence of different views which will then be shown 
one after the other, as if by camera panning. 

» Simulation - Simulation: Revised Videocodec dialogue window (SP2)  
The Videocodec dialogue window for the creation of videos has been revised: The 
“Data rate” checkbox is no longer available. 

» Subtract/Add, with translation - Extended options (SP2) 
These functions now offer additional options for the specification of the subtraction 
depths or the height of added sweep bodies. 

» New tapping screws (SP2) 
New tapping screws according to DIN EN ISO 10510 are now available. 

» Actual assembly surface (SP2) 
Use the Actual surface area of assembly function to calculate the actual surface 
area of assemblies. You select this function by right-clicking an assembly and 
selecting Properties &gt; .... HiCAD will calculate the surface area of the selected 
assemblies - including all sub-parts. Not considered will be all planar, parallel 
surfaces, the distance between which is smaller than the Distance tolerance 
specified in the dialogue window. In this way, double surface (contact surfaces) can 
be excluded from the calculation. This makes sense, for example, if you want to 
calculate the surface area that is relevant for galvanizing processes or similar. 

» Versioning of VAA variants (SP2) 
Variants in VAA_Format which are managed in HELiOS, will obtain a version number 
when they are changed.  If you load a drawing that contains a VAA variant, HiCAD 
will check whether this variant has been changed recently. If this is the case, a 
corresponding message will be displayed. 

» Double-sided weld seam (SP2)  
Double-sided weld seams such as double fillet welds or K-welds are now available.  
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12.1.4 Sheet Metal 

» Attach flange (SP2) 
The  Attach flange function offers several procedures for the attaching of flanges to a 
sheet. As soon as your data input is sufficient, a preview of the new flange will be 
shown, i.e. if you select a connecting edge, the possible flange will be displayed at 
the Sheet Metal part. If you have activated the Width via point(s), the new flange will 
be shown only after identification of a point and the width, or the identification of 2 
points, provided that you have selected the connecting edge. You will also 
immediately see the change on the Sheet Metal part if you switch from Ref. outer 
dimensions to Ref. inner dimensions. If the Apply immediately is active, the new 
flange will be immediately attached if the data input made sense, and can then only 
be changed via the feature log.  

» New cost calculation tool (SP2)  
The Sheet Metal Cost Calculation tool calculates the estimated production costs for 
laser-cut Sheet Metal parts on the basis of 2-D developments of Sheet Metal parts 
and various data such as cut contour lengths, number of bend zone, material etc.  

» Plugins in HiCAD Unfold (SP2)  
Plugins such as the new cost calculation tool can now also be integrated in HiCAD 
Unfold.  

» Collinear sheet edges (SP2)  
The automatic search for collinear sheet edges, e.g. during calculation of a sectional 
view or detail view, can be activated in the Configuration Editor.  

 

12.1.5 Plant Engineering 

» Accessory parts - Direct assignment switched off (SP2) 
If you have chosen the Database a spart data source, the assignment is made via the 
HELiOS-Desktop. There are two possibilities: 

 A data record acting as the top part of a product structure containing the set of the 
data records that belong to the accessory parts is assigned to the data record of 
the Plant Engineering part via a link of the type Part-Part. 

 The data record of the Plant Engineering part is converted to the top part of a 
product structure containing the set of the data records that belong to the 
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accessory parts (only limited suitability for HELiOS product structures!). As this 
possibility is no longer recommended, it will be deactivated from HiCAD 2014 SP2 
by default.  

» Part insertion - Hollow body, with all details (SP2) 
You can now choose between two degrees of detailing for part representation of 
hollow bodies.  

» Plant Engineering Settings - Part placing on branching points (SP2) 
The Plant Engineering Settings dialogue contains a new tab, Part placing on 
branching points.  

» Part exchange - Handling of non-reconstructible dimensions (SP2) 
If parts cannot be updated correctly after part exchange, because dimension base 
points are ambiguous after transformation or cannot be found any more, the 
dimensions which cannot be updated are marked and the following dialogue window 
is displayed. 

» Isometry - Indicate connected elements (SP2) 
A pipeline isometry provides a symbolic representation of the composition of a 
pipeline. In most cases, this pipeline is part of a larger plant in the layout plan. Within 
this layout plan there are other pipelines or components that are adjacent to the 
pipeline viewed in the isometry. Portions of these adjacent pipelines and components 
can be indicated to provide the observer with additional information on the pipeline 
environment. If the Indicate connected elements checkbox is active in the Plant 
Engineering Isometry dialogue window, the presence of connected pipelines will be 
indicated, e.g. by means of dashed representations.  

» Isometry and Pipe spool drawing - Redesigned dialogue windows (SP2) 
The dialogue windows for isometry and pipe spool drawing creation have had a 
redesign. The settings options which are different for both functions are now located 
at the bottom right of the windows.  

» Pipe spool drawing - Output to separate drawings and linking to HELiOS (SP2) 
Like isometries, pipe spool drawings can now be generated in separate drawings and 
linked to HELiOS. The previous limitation that you can select only one pipeline does 
no longer exist.  

» "Isometry + Pipe spool drawing" Ribbon tab (SP2) 
The previous Isometry Ribbon tab has been renamed to Isometry + Pipe spool 
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drawing tab and has been rearranged in such a way that it can be used both for 
isometries and pipe spool drawings. 

» New part type: Fasteners (SP2) 
The part type Fastener is intended for parts which are required for the connecting of 
particular pipe parts, but do not occupy any insertion length between the connected 
parts on the guideline.  

» Context menu for pipelines - Edit flow / Check flow (SP2) 
The Edit flow and Check flow functions are now also available in the context menu 
for pipelines. 

» Pipeline loops considered for pipe shortening (SP2) 
In previous HiCAD versions, loops in pipelines were never considered for pipe 
shortenings. This behaviour has been changed with HiCAD 2014 SP2, i.e. loops can 
also be considered.  

 

12.1.6 P+ID 

» Generation instructions in symbol data masks (SP2) 
In the data masks of P+ID symbols you can now enter a generation instruction 
containing key words and static text for the dialogue type Comment, or for user-
defined dialogue types. 

 

12.1.7 Steel Engineering 

» Management of manually assigned item numbers (SP2) 
If you assign item number manually, e.g. with the Part attributes   function, the 
corresponding parts will now be marked as "manually itemised". During automatic 
itemisation HiCAD will search for manually itemised parts or assemblies and checks 
whether they cause any conflicts - e.g. for identical part search.  

» Concrete stairs: Revised dialogue window (SP2) 
Das Dialogfenster für den Einbau von Betontreppen ist benutzerfreundlicher gestaltet 
worden. 

» Enhanced Design Checker (SP2) 
New Steel Engineering tests are available in the Design Checker: 
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 Maximum length and weight of assemblies  

 Maximum dimensions and weight of assemblies  

» Workshop drawing - Extended part selection options (SP2) 
For the creation of workshop drawings, the following two options are available in the 
Part selection listbox of the Derived drawing dialogue: 

 Selection list, with sub-parts (previously: Selection list) 

 Selection list, without sub-parts. 

» Indication of 45° cutting angles in BOMs (SP2) 
If you want 45° cutting angles to be indicated in the View (Flange) (Top view of cut) 
column (45° \--------|), open the system file STB_PARAMETER.DAT in the HiCAD sys 
directory and change the parameter accordingly.  

» Automatic assigning of types of use "Column assembly" and "Beam (girder) 
assembly" (SP2) 
During automatic itemisation you can automatically assign the types of use Girder 
(beam) assembly or Column assembly to Steel Engineering assemblies.  

» Notch - Significantly enhanced feature (SP2) 
The feature log for notches in Steel Engineering is now much more detailed. This 
allows an extensive processing and modifying of notches directly in the feature log. 

» New material designations for structural steels (SP2) 
In the Materials > Steel > Structural steels catalogue folder the material designations 
were outdated and have been adjusted accordingly. 

» Type of use-dependent annotations in workshop drawings (SP2) 
Part annotations in workshop drawings, too, can be applied depending on the types 
of use. For this to happen, you need to define the settings in the Configuration Editor 
(ISDConfigEditor.exe) accordingly, and create appropriate type of use-specific 
templates. You use the new Part annotation templates function to configure the 
templates for part annotation. 

» Assembly attributes - Additional tolerances acc. to DIN EN 1090 (SP2) 
In the attribute mask for assemblies you can find the Additional tolerances field, if 
your HiCAD product includes a Steel Engineering License. This field, where you can 
select additional tolerances according to DIN EN 1090 is important if you want to 
create weld seam test protocols. Default setting is Class 1 (EN 1090).  
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» Connections - Standardized error message windows (SP2) 
The error message windows (e.g. the ones that appear when a wrong beam is 
selected or if the insertion of a beam is not possible due to the position of the beams) 
have been standardized. 

» Connections - Standardized preview windows (SP2) 
The Apply button has been replaced by the Preview button in dialogues of the Type I. 
Click this button to display a preview of the connection, based on the current data.  

» Angle connection one-sided / double-sided (SP2) 
The previous connections girder connections DAST IW/IG one-sided and DAST IW/IG 
double-sided have been enhanced and combined into the new connections 1305 
and 1306. The old connections acc. to DAST IW (305) uand DAST IG (308) are no 
longer available. 

» New dimensioning rules for bores (SP2) 
A dimensioning of bores is now even possible if the bore axis runs perpendicular to 
the normal of the screen plane. However, this applies only if the axis additionally runs 
perpendicular to the dimensioning direction. 

» Welded beams and profiles (SP2) 
The new Welded beams/profiles menu (Steel Engineering > New > Standard  >...) 
contains the following functions:  

 Welded I-beams  ,  

 Welded box profiles  and  

 Welded cross-profiles  . 

» Text configurations (SP2) 
Text configurations can now be used for various HiCAD part types, i.e. not just for 
Steel Engineering parts.   
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12.1.8 Steel Engineering Drawing Management  

» HELiOSBIMConfig.EXE - "Article number" attribute (SP2) 
The length of the document attribute Article number has been changed from 30 to 
60 characters. If you have already used the Steel Engineering Drawing management 
module before HiCAD 2014 SP2, you need to execute the program 
HELiOSBIMCONFIG.exe (in the HiCAD EXE directory) once before using HiCAD 
2014 SP2.  

» Optimised default configuration (SP2) 
The default configuration for the Steel Engineering Drawing Management has been 
changed as follows. 

» Itemisation of locked parts (SP2) 
If you are using the Steel Engineering Drawing Management module, the setting for 
the Itemisation of locked parts parameter at PDM > Steel Engineering Drawing 
Management will be considered. There you can specify how parts with the 
HELiOS status “Released”, i.e. parts locked against processings by others, are to be 
handled. 

» Production drawing for unprocessed beams and profiles (SP2) 
The Steel Engineering Drawing Management module distinguishes between 
processed and unprocessed beams and profiles. The parameter Production drawing 
for unprocessed beams allows you to specify whether "unprocessed" beams and 
profiles are to be considered for drawing derivations or not. Default setting: Yes. 

» Drawing derivation - Changed menu caption (SP2) 
The first caption in the Derive pull-down menu has been changed to Create (formerly 
"Add"). 

» Create / Manage production documents (SP2) 
You have the option to auto-generate documents with production data for parts in 
workshop drawings created with the Steel Engineering Drawing Management module. 
These documents can be managed in HELiOS and linked appropriately. In case of 
changes to parts/assemblies it will be recognized whether or not the production data 
ia up to date.  
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» Manually referenced assemblies (SP2) 
In practice, the referencing of assemblies takes often already place in an early 
drafting stage, where the parts have not been itemised yet. This means that these 
parts have no automatically assigned Steel Engineering Drawing Management ID in 
the HELiOS part master and in the HiCAD part attributes.The STAHLBAUAUTO 
attribute allows a subsequent setting of this ID.  

» Change active assembly(-ies) with sub-parts (SP2) 
This new function enables a subsequent change of assemblies (including their sub-
parts) of already released parts - including automatic updating of the corresponding 
drawings and incrementing of the revision index. Depending on the setting in the 
Configuration Editor, the changes will be indicated by means of revision clouds. 

 

12.1.9 Metal Engineering 

» Transfer of item number to LogiKal (SP2) 
From  LogiKal Version 7.1.0.553 onwards, HiCAD item numbers can be taken over 
when performing exports from HiCAD to Logikal. In LogiKal they will be called 
"Custom names" and are displayed as "CUSTOMNAME" attributes. In this way the 
HiCAD item numbers can, for example, be shown on printouts of manufacturing 
orders or similar. 

 

12.1.10 Feature 

» Notch – Significantly enhanced feature (SP2) 
The feature log for Notches in Steel Engineering is now much more detailed. This 
allows an extensive processing and modifying of notches directly via the feature log. 
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12.1.11 Parametrics 

» Sketch HCM: Smart dimensioning (SP2)  
Optimum user-friendliness during working with the Sketch HCM provides the new 
Smart dimensioning function. Instead of having to select individual distance, angle or 
radius constraints and then assign them to geometries, you can use this function to 
automatically check which constraints are possible for a selected geometry element. 
These constraints will then be offered to you for selection and can be assigned with 
one mouse click.  

 

12.1.12 Report Manager 

» Indication of 45° cutting angles in BOMs (SP2) 
If you want 45° cutting angles to be indicated in the View (Flange) (Top view of cut) 
column (45° \--------|), open the system file STB_PARAMETER.DAT in the HiCAD sys 
directory and change the parameter accordingly.  

 

12.1.13 Variant Editor 

» Preview image when creating feature variant (SP2) 
When creating a feature variant, a graphical preview image will be automatically 
created for the Variant Editor. This is now also possible for shaded representation. 

» Versioning of VAA variants (SP2) 
Variants in VAA_Format which are managed in HELiOS, will obtain a version number 
when they are changed.  If you load a drawing that contains a VAA variant, HiCAD 
will check whether this variant has been changed recently. If this is the case, a 
corresponding message will be displayed. 

 

12.1.14 Viewer 

» Text representation (SP2) 
The representation of TrueType Fonts texts will be significantly enhanced in new 
drawings (as of HiCAD 2014 SP1). 
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12.1.15 Configuration Management 

» Performance (SP2) 
The performance for searches in the Configuration Editor has been increased 
significantly.  

» Take value from catalogue (SP2)  
Clicking the Select from catalogue icon enables you to take a value from the 
catalogue. Click the Remove entry icon to delete the presetting again.  

» "Automatically determine assembly/processed part" parameter withdrawn (SP2) 
At System settings > Start configuration, and also in the HiCAD Novice configuration, 
the parameter Automatically determine assembly/processed part is no longer 
available.  

» Selectable number of data backups (SP2)  
The number of the data backups (min. 2, max. 5) can be set in the Configuration 
Editor at ... > System settings > Data backup > Number of data backups (Default 2).  

» Assembly attributes - Additional tolerances according to DIN EN 1090 (SP2) 
At Modelling > Weld seams you can now find the new Additional tolerances 
parameter. This parameter will be evaluated in the attribute mask for assemblies, if 
your HiCAD product contains a Steel Engineering license. It is of importance if you 
are working with weld seam test protocols. 

» Radial pin calculation (SP2)  
To be able to use own templates for radial pin calculations, you need to expand the 
list at System settings > Calculations > Radial pin calculations accordingly. The 
templates must be stored in the HiCAD directorytemplates\SecurePinCalculation.  

» Settings for the Design Checker (SP2) 
At Analysis > Design Checker you can now preset the maximum values for the new 
Steel Engineering tests performed with the Design Checker. 

» Representation of isolated points / assembly points (SP2) 
The Stretch factor for isolated points parameter at System settings > 2-D Lines has 
been renamed to Enlargement factor... . The factor can be set separately for 
"normal" isolated points (Default: 1) and for assembly points (Default: 1.5).  
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» Changed default setting for weld seams (SP2) 
The default setting for the weld seam type has been changed. The new default 
setting at Modelling > Weld seams is the weld seam type Fillet weld. The weld seam 
type “Butt weld” is no longer available. 

» Referencing without database (SP2) 
At System settings > Referencing you can now find the new Automatic name 
selection for referenced parts without database entry checkbox. This setting is of 
importance when you save referenced parts without database entry, e.g. when 
creating standard parts, extruded or revolved parts while the Referenced checkbox is 
activated in the dialogue window. 

» Plant Engineering accessory parts: Switched off direct assignments (SP2) 
If you use the database as part data source, the assigning of Plant Engineering 
accessory parts will take place via the HELiOS Desktop. Formerly, you had the option 
to make the data record of the corresponding Plant Engineering part the top part of a 
product structure that contained the data records of the associated accessory parts. 
This option should no longer be used and is therefore switched off by default as of 
HiCAD 2014 SP2. If required, this settings can be re-activated via the Configuration 
Editor, namely, at Plant Engineering > Accessory part > Allow direct assigning 
without accessory set. Please note that these changes will only take effect after 
restarting HiCAD. 

» Enhanced pipe spool drawing functionality (SP2)  
Like isometries, pipe spool drawings can now be generated in separate drawings and 
linked to HELiOS. The previous limitation that you can select only one pipeline does 
no longer exist. Furthermore, the Plant Engineering settings in the Configuration 
Editor have been revised. At Plant Engineering > Isometry + Pipe spool drawing you 
will now also find settings for the extended pipe spool drawing functionality.  

» Pipeline loops considered for pipe shortening (SP2)  
In older HiCAD versions, loops in pipelines were never considered for pipe 
shortenings. This behaviour has been changed with HiCAD 2014 SP2, i.e. loops can 
also be considered. If you prefer to use the old procedure, start the Configuration 
Editor, select Plant Engineering > Isometry + Pipe spool drawing, and deactivate the 
Apply pipe shortening to pipeline loops checkbox.  

» Automatic assigning of the "Column assembly" and "Girder assembly" type of use 
(SP2) 
During automatic itemisation you can automatically assign the types of use „Girder 
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(beam) assembly“ or „Column assembly“ to Steel Engineering assemblies. For this to 
happen, open the Configuration Editor and set the parameter at Steel Engineering > 
Types of use accordingly. 

» Type of use-specific annotations in workshop drawings (SP2) 
The annotation of parts in workshop drawings can take place depending on the 
corresponding type of use. For this to happen, you need to specify the settings in the 
Configuration Editor, at Automatic drawing derivation > Type of use-dependent > 
name > Annotation accordingly, and have created the corresponding type of use-
specific templates. name here is the name of the corresponding type of use. 

» Itemisation of locked parts (SP2) 
If you are using the Steel Engineering Drawing Management module, the setting for 
the Itemisation of locked parts parameter at PDM > Steel Engineering Drawing 
Management will be considered. There you can specify how parts with the 
HELiOS status “Released”, i.e. parts locked against processings by others, are to be 
handled.  

» Production drawing for unprocessed beams and profiles (SP2) 
The Steel Engineering Drawing Management module distinguishes between 
processed and unprocessed beams and profiles. The parameter Production drawing 
for unprocessed beams (PDM > Steel Engineering Drawing Management) allows you 
to specify whether "unprocessed" beams and profiles are to be considered for 
drawing derivations or not. Default setting: Yes. 

» New dimensioning rules for bores in workshop drawings (SP2) 
A dimensioning of bores is now even possible if the bore axis runs perpendicular to 
the normal of the screen plane. However, this applies only if the axis additionally runs 
perpendicular to the dimensioning direction (Automatic drawing derivation > Type of 
use-dependent > BEAM > Set of dimensioning rules > Dimensioning rule 83 - 88. 

» Check default DB links (SP2)  
The default setting for the parameter System settings >HELiOS  Check default DB 
links has been changed. The default setting is now "Check and correct without 
query, with main part check".  

» Sheet Metal: Collinear edges (SP2)  
The automatic search for collinear sheet edges, e.g. during calculation of a sectional 
view or detail view, can be activated in the Configuration Editor, at Sheet Metal > 
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Hide collinear edges. The hiding of the collinear edges has no effect on sectional 
views created with the Only cut surface option. 

» Export free points and edges (SP2) 
Activate or deactivate the checkboxes for the options Export free point / free edges to 
specify the default settings for a writing out of data in HiCAD (Interfaces > General  
3-D interfaces). 

» Tolerances/fits for 2-D dimensions (SP2) 
When tolerances are created for 2-D dimensions, the tolerance values for 2-D 
dimensions are a result of a value selection or value input. The number of decimal 
places will be automatically detected, to enable the entered tolerance to be displayed 
entirely. The number of decimal places has no effect on the tolerance values and 
would therefore be removed from the Configuration Editor (Drawing > Annotations > 
Dimensioning 2-D > Decimal places, Tolerance value...). The tolerance values 
themselves will be preserved, as some users use them for their macros. 

 

12.1.16 Interfaces 

» CyCAD interface (SP2)  
HiCAD can also output DXF files in the "Cybelec CyCAD DXF" format, which contains 
additional information on bent sheets ("DXF Extended Entity Data").  

» IFC export – Contour or Exact/Simple (SP2)  
For exports into the IFC format you can now select whether a saving of the 
CONTOUR or of the EXACT/SIMPLE representation should be preferred.  

» SketchUp interface (SP2)  
HiCAD drawings can also be saved in the SketchUp format (.skp) .   

» CParts4cad - New buttons in dialogue window (SP2) 
Two new buttons are available in the dialogue window of the parts4cad  function – 
Reset catalogue list to supplied state and Download current catalogue list from 
Cadenas Server.  

» DSTV: Freely selectable file extensions (SP2)  
For DSTV-NC export you can now freely select the file extension, e.g. in cases where 
it is required to save a file with the extensiuon "nc1" instead of "nc" (which was 
previously done automatically).  
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» 2-D interfaces: System colours (SP2)  
When reading 2-D DXF, DWG or MI files into HiCAD, colours outside its colour 
palette (System colours &lt;40) will be distributed among the unused system colours.  

» PEPS export: Fits information (SP2)  
For PEPS export the standard processing file has been enhanced: It now contains fits 
information that can be additionally output and also evaluated by PEPS.  
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12.2 New in Service Pack 1 

12.2.1 Module-comprehensive 

» Direct Help and feedback on Help (SP1) 

 You can now immediately open the corresponding Help topics for the functions of 
the Ribbon and its expandable menus by pressing F1. 

 You can now submit your feedback on the Help via the footer of a Help topic. 

» Direct access to PartSolutions web catalogues (SP1) 

Use the new parts4cad  function to get direct access to the standard parts 
library of CADENAS. You can find the function at Drawing > Insert Part > Exp. .  

» Optimised representation of TrueType fonts (SP1) 
The representation of texts with TrueType fonts in new drawings (HiCAD 2014 or 
higher) has been enhanced significantly in HiCAD drawings created with HiCAD 
2014, SP1.  

» Multiple pasting of parts from HiCAD Clipboard (SP1)  
After pasting a part from the HiCAD clipboard the function remains active, i.e. you 
can paste the part several times to different locations in your drawing. To end the 
function, press the middle mouse button. 

» Find parts, via item number (SP1)  
When searching for parts with the key shortcut CTRL+F or the Find  function of 
the ICN, you can also enter a numerical range for item numbers, e.g. 200-500. 
HiCAD will then search for parts the item numbers of which fall into the specified 
range. 
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» Zoom to selection list (SP1) 

Use the Zoom to selection list  function to show the currently selected part list 
(multiple selection) as largely as possible on the screen. You will find the function on 
the transparent toolbar, or in the context menu for part lists (both in the drawing and 
in the ICN). 

» Scale suggestion when inserting drawing frames (SP1) 
If desired, you can now activate the new Suggest scale checkbox if you want HiCAD 
to automatically make a suggestion for a new main scale of your drawing.  

» Optimised user guidance error message texts (SP1) 
The user guidance texts for point specifications have been optimised. 

» Withdrawn system files / Configuration Editor (SP1)  
The system files  

 ALG3DPAR.DAT  

 LINPAR.DAT, 

 FEATURE.DAT, 

 SCHRIF.DAT, 

 TXTFONT.DAT and 

 SSWRITESTEP.DAT  

are no longer available. The setting options can now be found in the Configuration 
Editor (ISDConfigEditor.exe).  

» Operation of the Space Mouse (SP1) 
The speed of the movements is now proportional to the displacement of the space 
mouse. The reaction threshold in case of minor displacement and / or low speed has 
been changed. This enables you to perform slower movements as well. 

» Insert variant with catalogue entry via HELiOS part master (SP1) 
Variants with catalogue entry and HELiOS link can now be conveniently inserted by 

selecting Drawing > Insert Part > Insert part, via DB document master .  
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» Weld seam test protocols (SP1)  
The following new functions for the generation of weld seam test protocols (according 
to DIN EN 1090) are now available at Drawing > Itemisation/Detailing > BOM.  

 Weld seam test protocol, Drawing  

 Weld seam test protocol, Active assembly  

 

12.2.2 3-D 

» Taking into account of part lists for Show/Hide edges function (SP1)  

The dialogue of the Show/Hide edges in view  function (View > Properties) has 
been extended.  

 If a part list (multiple part selection) is active, it is now possible to re-display all 
hidden edges of the parts in this list again in one step.  

 If a part list (multiple part selection) is active, all parts of this list will be considered 
for the Hide via limiting angle option. 

» Assembly attributes - Execution class according to DIN EN 1090 (SP1)  
The attribute mask for assemblies now contains the new Execution class field, 
provided that your HiCAD product contains the Steel Engineering module. This is of 
importance if you want to create weld seam test protocols. In such cases you can 
select the execution class according to DIN EN 1090.  

» Weld seam tag with inspection category (SP1)  
In weld seam tags you can now display the test method according to DIN EN 1090. 

» Simulation – new features (SP1) 

 The context menu now contains the new Activate simulation assembly   
function. You can use this function to activate (in the ICN/in the drawing) the 
assembly to which the simulation is to be applied.  

 Motors and gravity can also be defined while the parts are in motion, i.e. while the 
simulation is temporarily stopped.  
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 The Create video dialogue window has been redesigned. A codec is not set 
permanently any more. Instead, the Videocodec selection dialogue will now be 
displayed whenever you call the Create video function. In the selection dialogue, 
the key frame rate instead of the data rate can now be set.  

 If the width of the Simulation docking window is reduced so that essential buttons 
are no longer visible, the simple time bar will be hidden automatically, so that the 
buttons are rearranged on the left side of the docking window. 

» Colour for Boolean operations (SP1) 
The colour of the active part will now always be applied to surfaces resulting from 
Boolean operations, i.e. the colour of added or subtracted parts will not be used. 

» Changed dialogues for Sketch functions (SP1) 
The dialogues for the Sketch functions Take over edges, Transition curve, Offset via 
point and value, Double-sided offset with end caps and Delete lines and isolated 
points have been revised. The End function in the context menus has been replaced 
by the Cancel function.  

» Delete cut-out, Individual (SP1) 

The Delete cut-out, Individual  function (Views > Edit > CutOut ) will now always 
remain active after the deletion of a cut-out, enabling you to immediately select 
further cut-outs to be deleted. Right-click to end the function. 

» Freeze/unfreeze views (SP1) 
To unfreeze frozen views again, the name of the corresponding function has been 
changed to "Unfreeze" for a better understanding (the previously used "Update" was 
less clear). 

» Assign surface / edge colour (SP1) 

When you select the Surface colour and Edge colour  function, the colour of 
the active part will now be displayed immediately. If the Drawing colour has been 
activated, the Drawing colours tab of the list will be opened, if the System colour has 
been activated, the System colours tab will be displayed, accordingly. 

» New settings for itemisation tags in the Configuration Editor (SP1) 
You can now specify in the Configuration Editor (ISDConfigEditor.exe) at System 
settings > Annotation tags > Querying of coincident points how to proceed for the 
identification of itemisation tag base points that coincide with other points. This 
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concerns the following functions of the Text function group on the 3-D Dimensioning 
+ Text Ribbon tab: 

 Part annotation, with free text and leader line 

 Standard designation, and 

 Itemise part. 

» New Standard Parts: Dished ends (SP1) 

 New in the Factory Standards > Parts + Processings catalogue are Dished ends 
acc. to DIN 28011 (torospherical) and Dished ends acc. to DIN 28013 (semi-
ellipsoidal). To insert the dished end, select 3-D Standard > Standard Parts > 

BoltScrew > Others > Dished ends . 

» Feather keys and Feather keyways (SP1) 
The two functions Feather key and Feather keyway have been optimised. Their 
dialogues have remained unchanged.  

» Change BOM-relevance: Consider sub-parts (SP1) 

When selecting the BOM-relevance  function, you can now apply the change 
either only to the selected parts/assemblies, or also to their sub-parts. If you want to 
do the latter, Include sub-parts checkbox. The function can be found in the context 
menu for parts and part lists (right-click part and select Properties > BOM-
relevance). 

» Sketches - Double-sided offset with end caps (SP1) 

The dialogue window of the Offset with end caps function has been changed. If 
the Line option has been chosen, the offset ends will only be filleted if the Radius has 
been activated. Otherwise, the offset ends will be directly connected by a line. 

» Sketches - New Chamfer and Fillet dialogue windows (SP1) 

 The functions for the applying of Fillets and Chamfers to corners of sketches have 
been redesigned and enhanced. You can now automatically assign HCM 
dimensional constraints during the chamfering or filleting process. Furthermore, 
additional processing functions for the selected lines and edges are available in a 
context menu. 

 The Fillet sketch, Point on arc function is no longer available.  
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» Chamfer - Switch lengths (SP1) 
The 2 lengths option of the Chamfer function now enables a subsequent switching of 
lengths. This allows you to define to which side of the selected edge the specified 
chamfer lengths will be applied. 

» Clone + Mirror (SP1) 
When you select the Clone + Mirror function, the (internal and external) referencings 
as well as links to HELiOS will be removed in the created copy. This means that if the 
original part is a referenced part or a part linked to HELiOS, these properties will not 
be applied to the copy as well. If the original is an assembly, this principle will be 
applied recursively to all sub-parts. Exception: Links to HELiOS will be preserved in 
copies of standard parts. 

» Wrap - "Marking" mode (SP1) 

 A preview is now also shown when you use the Wrap function for Sheet Metal 
parts. 

 If you select the Marking mode of the Wrap function, open sketches will also be 
allowed. 

» Set symbol - Close dialogue window with double-click on symbol (SP1) 
When you use the Set symbol function to insert symbols in a dimension text, the 
dialogue window will be closed automatically when you select the symbol by double-
clicking it. 

» Cloning of parts with external references (SP1) 
When cloning parts with external references (e.g. processings referring to elements of 
different bodies), the external references will only be taken over if the part to which 
the reference is made will also be copied. If a part with external reference is copied 
without the corresponding reference part, the option will be set to External 
references in processings: Do not use. 
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12.2.3 Sheet Metal 

» 'Puzzle piece' Design Variant in parallel flange surfaces (SP1) 
You can now also connect parallel Sheet metal flanges with the Puzzle piece Design 
Variant. 

» 'Cam joint' Design Variant in sheet surface (SP1) 
A new Cam joint variant is now available: The connection can now also be placed into 
surfaces of sheets. 

» ACP for aluminium composite panels (SP1)  
The allowance method ACP is available for aluminium composite panel blanks. 
Development and milling dimensions are derived from the 3-D drawing dimensions. 
Per edge, the corresponding linear dimension will be subtracted from the final 
dimension. The sum of the milling dimensions equals the blank dimensions. 

» Lengthen flange (SP1) 

The Lengthen in sheet direction, to total length  function has been added to the 
Change length function group of the Sheet Metal tab of the Ribbon. You can find the 
function in the pull-down menu of the Flange function. This new function enables 
you to lengthen or shorten a flange or a bend zone by entering the new total length. 

» Insert Standard Processings in several sheet flanges (SP1) 
Most punching holes can be fitted as single or several holes on a linear, polar or 
radial grid. Once you have selected the object to be fitted, the Grid menu is shown. If 
you select the sheet main part instead of a sheet flange, you can insert standard 
parts and processings (e.g. holes) along all flanges of the part (not possible for 
threads, moulding tools, letterings). 

» Sheets with textures (SP1) 
If you drag a texture onto the sub-part of a Sheet Metal main part, the texture will be 
applied to the complete Sheet Metal main part. 

 



What’s New in Version 2014? 

   157 

12.2.4 Plant Engineering 

» DbPlantDataImport – Always generate new database IDs (SP1) 
The DbPlantDataImport dialogue window now contains the new Always generate 
new database IDs checkbox. If this checkbox has been activated, the database IDs 
saved in the archive files (VAA or PAA files) will not be used for part data import. 
Instead, newly generated database IDs will be used, which will then automatically be 
transferred to the corresponding archive files. This means: The database IDs that 
previously existed in the archive files will be overwritten with the new ones! 

» New Plant Engineerinjg Variants (SP1) 
Many new Plant Engineering variants are available, e.g. EBRO wafer valve, AZ brass 
ball valve, HydroWer locking device and weld-in flange for tanks, STENFLEX rubber 
compensator, havit SAE flanges, Flansche, Viega expansion nipple, elbows, caps and 
sockets as well as various Swagelok joints.  

» Weld seam gaps for connection types 52000/10000 (SP1) 
Weld seam gaps can now also be inserted for the connection types 52000 socket-
welded, socket  and 10000 butt-welded . 

» Plant Engineering Settings: Part search (SP1) 

 On the Part search tab, all checkboxes of a column can now be activated or 
deactivated via the red icons in one step, without locking the access to the 
checkboxes in the rows below, as was formerly the case. 

 The new Connection types button enables you to specify the allowed 
combinations of connection types which should apply when connecting two parts. 
This will be taken as a basis for the automatic determination of the search criteria 
for the connection type attributes of the part to be connected. 

 If the Show search criteria if part search unsuccessful checkbox has been 
activated, the search criteria you have used will be shown after an unsuccessful or 
aborted part search. 

» Plant Engineering Settings: Straight pipe (SP1) 

 The setting option Auto-determine insertion direction via connection types is no 
longer available. 
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 New setting options for automatic insertion of connecting parts between straight 
pipes are now available, for cases where the guideline is longer than the maximum 
pipe length (supplied length). 

» T-pieces, 3-way valves and branches on guideline corners (SP1) 
You can now use the ...on edge branching option to place T-pieces selected with the 
Pipe parts function onto guideline corners. This option is also possible for 3-way 
valves and branches.  

» Replace elbow with T-piece, 3-way valve or branch (SP1) 
You can now use the Exchange parts function to replace an elbow, a knee or a 
corner valve with a T-piece, a 3-way valve or a branch. The procedure is identical to 
that for the placing of T-pieces, 3-way valves or branches on guideline corner points. 

» Copy guideline (SP1) 

Use the same-named function to Copy guidelines  . The copy can then be 
assigned to any pipeline. Parts can already have been placed on the guideline. The 
copy will look like the original guideline after deletion of the parts on it. 

» Delete loose flanges (SP1) 
A loose flange on a free pipe end can now be deleted individually. A loose flange 
which is attached to another flange connection can only be deleted if the pipe to 
which the flange belongs is deleted. 

» Isometry/Pipe spool drawing - Assign part/length item numbers according to part 
properties (SP1) 
In the isometry and in the layout plan it is now possible to link the sequence of 
assigned part and length item numbers to the order of self-defined part properties on 
the Item numbers tab of the settings dialogue window.  

» Isometry/Pipe spool drawing - Consider connection types when assigning 
connection item numbers (SP1) 
When assigning connection item numbers it is often desired to exclude certain 
connection types from itemisation. This can be achieved by activation of this 
checkbox. To assign item numbers to a connection type, select the connection type 
from the list box, and activate the Assign item numbers checkbox on the 
Connections tab of the settings dialogue window. 
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» Isometry/Pipe spool drawing – Sorting of BOM items  (SP1) 
Normally, the BOMs of the isometry are sorted according to the assigned item 
numbers. If you want a different sorting, click the desired button below Sort... . 

» Isometry/Pipe spool drawing - Preserve manually entered data in BOMs (SP1) 
The BOMs of isometries and pipe spool drawings are generated from data that is 
provided by the pipeline itself. Such a BOM can be edited after its generation, and 
the changes can be saved in the BOM. If the pipe spool drawing or the isometry is 
now re-generated, e.g. because the pipeline has been changed, all BOMs will be re-
generated as well. In older versions (before HiCAD 2014 SP1), all data that was 
entered manually via the editing functions was then lost. In the Lists tab of the 
Settings dialogue for pipe spool drawings you have now the option to define for 
individual columns of a BOM that their values can be filled in manually afterwards. 
For this you use the Editable column button. 

» Isometry - Edit flow directions (SP1) 

Use the Edit flow direction    function (Plant Engineering > Isometry/Pipe spool 
drawing  > Ref. > ...) to define the flow direction at each connecting point already in 
the layout plan. In this way, data the generation of which depends on flow directions 
do not need to be adjusted in the isometry. The most important of such data are 
connection item numbers which are assigned along a flow route. For isometries you 
will find the function at Isometry > Symbols > Edit flow direction. The function 
replaces the Reverse flow direction function, which can still be accessed via the 
context menu for flow direction arrows.  

» Pipe spool drawing - Automatic generation and other new features (SP1) 

 Previously, a pipe spool drawing needed to be generated manually in several 
steps. As of SP1 this will no longer be necessary. As of SP1 this will no longer be 
necessary. The pipe spool drawing is now automatically generated in a new sheet 
area, using the parts that have been previously marked and belong to the selected 
pipeline. 

 The Remove pipe spool drawing function is no longer available. As pipe spool 
drawings are now generated on separate drawing sheets, they can now be 
removed by simply deleting their sheet. 

 In the Generate pipe spool drawing menu, the functions Edit part list, Edit length 
list and Edit connection list are no longer available. To edit a BOM in the pipe 
spool drawing, right-click the BOM and select the function in the context menu. 
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 New in the Generate pipe spool drawing menu are the functions: Renew item 
numbers, For parts; Renew item numbers, For pipe lengths and Renew item 
numbers, For connections. 

» Move points (SP1) 
The Plant Engineering function Move points, in rectangle has been replaced with the 
3-D function available at 3D-Standard > Process > Move Pts, which can now also be 
used for Plant Engineering drawings.  

 

12.2.5 P+ID 

» Delete complete pipeline (SP1)  
This new function allows you to delete a pipeline completely from the current P+ID 
sheet. This means that all symbols and connections belonging to the selected 
pipeline, as well as the corresponding pipeline symbol will be deleted. Furthermore, 
all connections linked to the deleted symbols will be deleted as well.  

» Symbol ID management for library symbols (SP1)  
The new Symbol version is a 32Bit integer value initialised with “0”. After each 
saving of the symbol via the Library Symbol Editor, a time ID will be assigned to it 
according to UTC (Coordinated Universal Time). This means that library symbols now 
distinguish themselves not only by their library names and symbol names, but also 
by their version ID.  

» Scale symbol (SP1)  
After scaling, the symbol library name of the symbol will be changed to 
_UNKNOWN_. If there are further symbols with the same symbol name and the 
same symbol library name (_UNKNOWN_) in the active project, the symbol version 
ID will be incremented.   

» Save symbol as library symbol (SP1)  
Use the new Save as library symbol function to save a symbol from the loaded P+ID 
as a library symbol to a symbol library. After its selection, the symbol will be loaded 
into the Symbol Editor, and the symbol dialogue mask will be opened. Here you can 
change, for example, the symbol name.  
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» Position dialogue text in P+ID (SP1)  
For all dialogues the text inputs of which are to be graphically displayed next to the 
symbol, use the Position dialogue text to specify the position of these texts. This is 
also possible while the P+ID is open. A selection list with the dialogue designations 
existing in the symbol data mask will be displayed, where you can select the desired 
dialogues one after the other.   

» Edit symbol data mask in project (SP1)  
A composition of the symbol data mask is now also possible in the P+ID project. The 
3 functions Individual, Sheet and Rectangle are available for symbol selection. 

» Allow deviation from pipe class (SP1)  
If in the P+ID a symbol belongs to a pipeline symbol, and a pipe class has been 
assigned to the pipeline symbol, the pipe class had previously always been used as 
search criterion for the assigning of a part to the symbol.The new setting option Allow 
deviation from pipe class allows you to deactivate the pipe class as search criterion.  

» Print project (SP1)  
The Print project function now also uses the Print HPGL dialogue window for the 
printing of P+ID drawings.  

» Cancel work after abnormal program termination (SP1)  
When HiCAD needs to restart after an abnormal program termination (e.g. via Task 
Manager) or a program crash, and switches to the P+ID module, HiCAD will ask you 
whether you want to continue (Yes) or cancel (No) your work on the data from your 
working directory. If you select No, the working directory will be deleted.  

» Additional P+ID notes in ICN part structure (SP1)  
When you load a P+ID sheet, HiCAD will now display an additional descriptive text for 
each 2-D part that has been created or inserted with a P+ID function in the 2-D part 
structure window of the ICN. If the 2-D part belongs to a P+ID symbol for which a 
data mask exists in the P+ID, the descriptive text from the data mask will be 
displayed. Normally, this will be the text that was already supplied as a description for 
the symbol in the symbol library.  
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12.2.6 Steel Engineering 

» Welded beams/profiles (SP1) 
The new Welded beams / profiles sub-menu is available at Steel Engineering > New 
> Standard > .. The following beams and profile can be inserted: 

 Welded I-beam  

 Welded box profile  

 Welded cross-profile  

» Railing Configurator - Extended dialogue window (SP1) 

 Explanatory images are now also available for Vertical rods with frames on the Infill 
tab of the dialogue window. Furthermore, you can now also select steel pipes for 
this type of infill elements. 

 A new variant is now available in the Catalogue Editor, at Factory standards > 
Series > Railing > Handrail. The new variant is based on a series profile and can 
be extended by further data sets if desired.  

» Base plate + Anchor plate - With weld seams (SP1) 
The exact position of weld seams can now be specified for the Base plate + Anchor 
plate (1101) design variant. The following options are available: 

 between base plate and beam, 

 at the ribs (between beam and ribs, between ribs and base plate), 

 between anchor plate and welded plate, or 

 between anchor plate and shear connector. 

» Avoirdupois weight for assemblies (SP1) 
If you are using avoirdupois weights in Steel Engineering, the weight will also be 
entered into the part attributes. As of SP1 this also applies to the corresponding 
assemblies, i.e. the sum of the avoirdupois weights will be used for the attributes. 
Avoirdupois weights of assemblies can then also be transferred to BOMs. 
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» Front plate connection 1 to web/flange - Flush mounting of 2 stiffeners (SP1) 
If you insert 2 stiffeners in the front plate connection 1 to web/flange (1320), they 
will be mounted flush to the flange. If you insert only 1 stiffener, the stiffener will be 
placed in a centred position. 

» Weld seams - Inspection category and test protocol (SP1) 

 In weld seam tags you can now display the test method according to DIN EN 
1090. To do this, select the desired value from the Inspection category list box in 
the dialogue window for the weld seam representation. The inspection categories 
have been predefined in the Configuration Editor, at Modelling > Weld seams. 
They are evaluated in weld seam test protocols. 

 Use the functions Weld seam test protocol, Drawing  and Weld seam test 

protocol, Active assembly  to display the scope of a weld seam inspection in 
the form of a weld seam test protocol. The test protocol contains, for each 
execution class and inspection category acc. to DIN EN 1090, the total length of 
the weld seams. 

» Derived drawing - "Type of use"-dependent drawing frames (SP1) 
For drawing derivations, you can now make the use of drawing frames dependent on 
the type of use of a part. This option is only possible for detail drawings and can be 
switched on and off in the Configuration Editor. Select Automatic drawing derivation 
> Use-case dependent > (e.g. BEAM) > Drawing frames. The parameter Adjust 
scale to frame size, too, can be set to "type of use-dependent". This parameter also 
applies to detail drawings only. 

» Reading of referenced Steel Engineering parts (SP1) 
Drawings containing referenced Steel Engineering parts are now loaded much faster. 

» Assembly attributes - Taking over of part dimensions (SP1) 
For automatically created assemblies in Steel and Metal Engineering you can 
automatically detect the attributes Length, Height and Width from the dimensions of 
the parts belonging to the assembly, and enter them into the assembly attributes. If 
desired, you can change this behaviour in the Configuration Editor, at Modelling > 
Part properties > Update part dimensions. 
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» Mapping table for import via DSTV product / statics interface (SP1) 
A new mapping table is available for the import of parts from foreign systems via the 
DSTV product / statics interface. A large number of foreign identifiers will be mapped 
to the corresponding HiCAD key, and "translated" accordingly during import. 
Additional user-specific assignments are also possible. The table can be found in the 
Catalogue Editor, at Factory standards > DSTV > DSTV Mapping ISD. 

» DSTV -NC: Calculate punch marks automatically (SP1) 
HiCAD now provides an additional option for the output of punch marks in DSTV-NC 
exports, which enables an automatic calculation of punch marks and their writing to 
the DSTV-NC file.  

 

12.2.7 Steel Engineering Drawing Management  

» Withdrawn functions (SP1) 
The Update drawing, without PDM function is no longer available. 

» Bills of Materials (SP1) 
The BOM function at Drawing management > Production is now also available at 
Drawing > Itemisation/Detailing. The functions enable you to generate Bills of 
Materials for active parts or assemblies. 

 

12.2.8 Metal Engineering 

» Grid assembly - Design Variant 3-D Metal Engineering connection for Schüco FW 
50/60 (SP1) 
If you work with the 3-D Metal Engineering planning grid (Metal Engineering > Grid 
...) and want to insert the grid connections via a Design Variant, use the 3-D Metal 
Engineering connection for Schüco FW50/60 Design Variant that is already known 
from the Civil Engineering functions. 

» 'Puzzle piece' Design Variant (SP1) 
A new variant of the Puzzle piece Design Variant for Sheet Metal parts is now 
available, which allows a connection of parallel sheet flanges 

» Assembly attributes - Taking over of part dimensions (SP1) 
For automatically created assemblies in Steel and Metal Engineering you can 
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automatically detect the attributes Length, Height and Width from the dimensions of 
the parts belonging to the assembly, and enter them into the assembly attributes. If 
desired, you can change this behaviour in the Configuration Editor, at Modelling > 
Part properties > Update part dimensions. 

 

12.2.9 Feature 

» Cloning of parts with external references (SP1) 
When cloning parts with external references (e.g. processings referring to elements of 
different bodies), the external references will only be taken over if the part to which 
the reference is made will also be copied. If a part with external reference is copied 
without the corresponding reference part, the option will be set to External 
references in processings: Do not use. 

» The system file Feature.dat is no longer available. Its settings have been moved to the 
Configuration Editor.  

 

12.2.10 Parametrics 

» AutoDimension edge lengths (SP1)  
The dialogue of the Automatic dimensional constraints function (Sketch > HCM > 
Distance > ...) now offers additional options for auto-dimensioning of edge lengths for 
lines, circles, ellipses and splines. 

» Show HCM constraints of individual part in ICN (SP1) 
You can now display only the HCM constraints of an individual part of your choice in 
the HCM tab of the ICN. To do this, open the 3-D Standard tab, choose HCM > Tools 
> ICN, individual part and select the desired part. 

» Sketch HCM:  Removed setting options (SP1)  
The AutoConstraints visible and Display constraints (constraints automatically 
assigned by HiCAD) have been removed from the Sketch HCM.  
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12.2.11 Report Manager 

» Template for weld seam test protocols (SP1) 
HiCAD offers the option to output the scope of a weld seam ispection in the form of a 
weld seam test protocol. The test protocol contains, for each execution class, and 
inspection category according to DIN EN 1090, the entire lengths of the weld seams. 
A predefined configuration file for the Report Manager, hicad_weld_inspection.RMS, 
is available for the generation of the weld seam test protocols. 

» User-defined column headers from HELiOS (SP1) 
If you use user-defined column headers in for the result lists in HELiOS, these will 
also be used for a transfer to the Report Manager. 

 

12.2.12 Catalogue Editor 

» Mapping table for import via DSTV product / statics interface (SP1) 
A new mapping table is available for the import of parts from foreign systems via the 
DSTV product / statics interface. A large number of foreign identifiers will be mapped 
to the corresponding HiCAD keys here, and "translated" accordingly during import. 
Additional user-specific assignments are also possible. The table can be found in the 
Catalogue Editor, at Factory standards > DSTV > DSTV Mapping ISD. 

» New Standard Parts (SP1) 

 Axial spherical roller bearings according to DIN 635-2 are now available. 

 New in the Factory Standards > Parts + Processings catalogue are Dished ends 
acc. to DIN 28011 (torospherical) and Dished ends acc. to DIN 28013 (semi-
ellipsoidal). In addition, you have the option to insert user-specific dished ends. 
These must be located in the Factory standards > User-defined dished ends 
catalogue. A corresponding table for this purpose has been predefined by the ISD. 
To insert the dished end, select 3-D Standard > Standard Parts > BoltScrew > 

Others > Dished ends . 
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12.2.13 Variant Editor 

» Preview image when creating feature variant (SP1) 
When creating a feature variant via Drawing > Save/Reference > Part > Create 

feature variant , a graphical preview image will be automatically created for the 
Variant Editor, provided that the shaded representation has not been activated. 

 

12.2.14 Configuration Management 

» Takeover of .DAT system files (SP1) 
The system files 

     ALG3DPAR.DAT 

     FEATURE.DAT 

     SCHRIF.DAT 

     TXTFONT.DAT 

     LINPAR.DAT 

 SSWRITESTEP.DAT  

are no longer available. The settings from the files have been integrated into the 
Configuration Editor and are now available there.  

» Enhanced configuration structure (SP1) 

 In the settings for weld seams, you can now also specify the so-called Execution 
class for weld seam test protocols.Weld seam test protocols are a special type of 
BOM used for Steel and Metal Engineering, enabling you to determine the scope 
of weld seam inspections according to DIN EN 1090 (Modelling > Weld seams...). 

  You can set in the Configuration Editor how to proceed for the placing of 
itemisation tags, if coincident points are identified as base points. (System settings 
> Annotations > Annotation tags ...) 

 The setting options for the projection grid, such as Grid origin or Projected grid, 
have been transferred to the Configuration Editor as well (System settings > 
Processing plane > Projection grid). 
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 Extended representation options for Grid annotations are now available (Drawing > 
Annotations > Grid annotation...). 

 The settings for Plant Engineering have been expanded in the Isometry and Pipe 
spool drawing section. If you do not want to be prompted to select parts before the 
dialogue appears, you can switch this behaviour off. If no parts are selected, the 
entire pipeline will be used (Plant Engineering > Isometry and Pipe spool drawing 
...). 

 The settings for view arrangement in pipe spool drawings is now available in the 
Configuration Editor. Each view configuration consists of several views which can 
refer to each other (Plant Engineering > Isometry and Pipe spool drawing > View 
arrangements). 

 The behaviour for the loading of locked documents can now be set in the 
Configuration Editor (PDM > HiCAD-HELiOS interface...) 

 Due to the moving of the ALG3DPAR.DAT settings to the Configuration Editor, the 
Modelling section now contains two additional sub-sections, Part properties and 
Change of part structure. (Modelling > ...). 

 Due to the moving of the FEATURE.DAT settings to the Configuration Editor, the 
setting options in the Feature section have been extended (System settings > 
Feature ...). 

 Due to the moving of the SCHRIF.DAT settings to the Configuration Editor, you can 
now specify the Aspect ratio and the Inclination angle for HiCAD fonts (System 
settings > Text > Type) . 

 The assigning of HiCAD fonts to the font file can now me set in the Configuration 
Editor (System settings > Text > HiCAD-Fonts). 

 The settings for 2-D lines (colour, layer etc.) from the LINPAR.DAT file have been 
integrated into the Configuration Editor (System settings > 2-D Lines ...). 

 At Drawing > Annotations > Plot stamp you can specify the font and the other text 
properties for the plot stamps used in the Plot Manager. 
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12.2.15 Interfaces 

» Direct access to PartSolutions web catalogues (SP1) 

Use the new parts4cad  function to get direct access to the standard parts 
library of CADENAS. You can find the function at Drawing > Insert Part > Exp. .  

» Mapping table for import via DSTV product / statics interface (SP1) 
A new mapping table is available for the import of parts from foreign systems via the 
DSTV product / statics interface. A large number of foreign identifiers will be mapped 
to the corresponding HiCAD key, and "translated" accordingly during import. 
Additional user-specific assignments are also possible. The table can be found in the 
Catalogue Editor, at Factory standards > DSTV > DSTV Mapping ISD. 

» DSTV -NC: Calculate punch marks automatically (SP1) 
HiCAD now provides an additional option for the output of punch marks in DSTV 
exports, which enables an automatic calculation of punch marks and their writing to 
the DSTV-NC file.  

» DSTV-NC: Attribute configuration (SP1) 
The new Attribute configuration option enables a much more flexible assigning of 
Lettering, Part number and Item number during DSTV-NC export. Instead of either 
outputting the item number, or the article (part) number as the Item no. on attribute, 
you can now assign values to both numbers via system files , and write them into the 
DSTV-NC file.  

» JT Interface: New export options (SP1) 
JT files can now be exported with some JT-specific attributes, in addition to the usual 
options for 3-D CAD formats. This includes the Filestructure (Monolithic, PerPart, 
FullShatter, Mimic), as well as the possibility to export the geometry in BREP form 
("Boundary Representation", older JT representation method). Furthermore, you can 
select a Detail level, enabling you to export up to 9 different accuracy levels of the JT 
model. 
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» Update CADfix 9.0 SP3 and Unicode characters in file names (SP1) 

 Due to the integration of the CADfix updates 9.0 SP3, the following format versions 
are now available in HiCAD: NX 9, SolidWorks 2014, Inventor 2014, JT V7.0, 
Parasolid 26.1 and ACIS R24SP2. 

 Furthermore, the support of Unicode characters in file names has been optimised. 
They are now supported for almost all formats, except for Catia V5 and Pro/E, 
where many special characters are not allowed in the names, and will therefore be 
replaced automatically. 

» 3D-PDF: Output of multiple views (SP1) 
When creating a 3D-PDF file, seven perspective view will be generated: 

     Standard AXO 

     Front view 

     Side view, from left 

     Top view 

     Side view, from right 

     Back view 

     Bottom view 

» Textures for 3D-PDF and VRML export (SP1) 
If textures have been assigned to parts, these textures will be considered for VRML 
and 3DPDF export. 

» DXF: Output of plot stamps (SP1) 
In the same way in which you can output plot stamps for printing or PDF export via 
HiCAD Spooler, you can also write them to the (2-D) DXF format. Please note that 
this is not possible for "interactive" DXF export. 
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12.3 New in Major Release 

12.3.1 Module-comprehensive 

» Feedback on the Help  
If you want to report errors in the Help or let us have your suggestions, please email 
us at helpfeedback@isdgroup.com. 

» New simulation tool with time bar 
The new simulation tool enables an even more realistic and precise simulation of 
machines and plants. Available are two modes: 

 Motion simulation (Animation) 
Enables you to assign motors to the parts to control their movements (translations 
or rotations). This also includes a collision check. Furthermore, you can define 
time intervals for the simulation. 

 Physical simulation 
Here, too, movements are controlled by the definition of associated motors. If in 
this mode a moving part collides with a motionless part, the latter will also be 
moved as a result. Unfixed (HCM) parts will drop as a result.  

In contrast to the other HiCAD simulation technologies, HiCAD distinguishes here 
between the calculation speed of the simulation and the "Play" speed of the simulation. 
While for the technologies listed below the "Play" speed depends on the performance of 
the computer used, the "Play" speed here corresponds exactly to the specified speed. 

» The functions that used to be available in HiCAD via 3-D Standard > HCM will no 
longer be located on the Ribbon from HiCAD 2014 onwards. To access these 
functions, click on the Settings  icon at the top right, select Toolbars and activate 
the Simulation checkbox. For new simulations, please always use the new Simulation 
docking window. 

» Performance  

 The recalculation of normal views has been optimised. The performance for 
zooming and moving of views could be increased by a factor of >; 10 (depending 
on the size of your drawing).  

mailto:helpfeedback@isdgroup.com
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 Due to the restructuring of the HiCAD data storage unit (part-oriented data 
storage), the overall performance could be enhanced significantly. This applies in 
particular to the updating of assemblies and Steel Engineering connections. 

 HiCAD 2014 comes with a new core algorithm for Boolean operations, which is 
also used for the Add, Subtract or other functions. This new algorithm, too, 
ensures a higher performance, especially for changes of parts and assemblies via 
feature log. 

» Online Help in HTML5 format with new Search function 
The Online Help has been converted to HTML5 format, resulting in a significantly 
faster operation. The Search function has also been enhanced.  

» AutoSave 
The AutoSave mechanism is inactive in drawing files which are opened in read-only 
mode. For example, this is the case with drawing files that have already been opened 
on another workstation.  

» OpenGL  
The capacity for OpenGL display lists is unlimited now by default, i.e. HiCAD uses the 
full OpenGL capability of your graphics card. The setting is specified in the file 
GRAPAR.DAT in the HiCAD SYS sub-directory. (Line 69/70): 

» Enhanced Design Checker  
The Design Checker, a tool that allows you to check your drawings for possible errors 
(invalid features, incorrect boltings, dummy parts etc.) has been enhanced. 

 Besides the active drawing, you can now also check all assemblies of a selection 
list. 

 New Steel Engineering tests are available, enabling you to check the BOM-
relevance of assemblies and main parts, as well as the part structure. 

 Also new is a test for Sheet Metal parts that enables you to check whether the 
blank sizes of sheet developments exceed the maximum dimensions according to 
the sheet dimensioning table in the Catalogue Editor (Factory standards &gt; Sheet 
dimensions). The sheet dimensioning table in the Catalogue Editor consists the 
practice-oriented dimensions (Column L1 and W1) for the corresponding materials 
and sheet thickness (Column T).  

 The operation of the tool and the dialogue window have been optimised. For 
example, you can now zoom in on the parts that cause errors, or expand/collapse 
all test results in one step. 
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 While the Design Checker dialogue window is open, you can apply any changes to 
the drawing, e.g. recalculate features, hide or show parts, modify parts, delete 
parts etc.) 

» Save part – new option for variants 
The Reference part, Save, Detail drawing function to save variants to HiCAD 
catalogues. For this purpose, a new option has been added to the dialogue window. 

 

12.3.2 2-D 

» Part display lists  
The performance for image buildup while using Part display lists has been enhanced 
significantly. For hatchings and overlaps now up to 50 times faster. 

» Copy texts  

 Copy text, with Sketch  
This new function enables you to copy texts and move them using Sketch 
technology. 

 Copy text, via 2 points  
Enables you to define, via specification of 2 points, a distance by which the 
previously identified and copied text will be moved.  

» 2-D part structure in colour  
The 2-D part structure in colour function is no longer available. 

» Verdeckungslevel ändern  
If you change the overlap level of a main part, you have the following options for the 
sub-parts: 

 Do not change level: Cancels the function. The overlap level will remain 
unchanged.  

 Set level: Changes the overlap level of the super-ordinate part and the sub-
ordinate parts (e.g. Level 1 / Level 2 will become Level 10 / Level 10).  

 Adjust level: Changes the overlap level of the super-ordinate part and adjusts the 
overlap level of the sub-ordinate parts (e.g. Level 1 / Level 2 will become Level 10 / 
Level 11). 
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12.3.3 3-D 

» Sketch - Double-sided offset with end caps  
A new Offset function for sketches is now available at Sketch > Derive > Offset .   

Use the new Offset with end caps  function to insert double-sided offsets 
i.e.parallel lines/curves or concentric circles to both sides of a selected graphical 
element into the active sketch or 3-D sketch. You can also specify in the process how 
the corners and the ends of the resulting composite edges are to be handled. 

» Sketch – Take over text contours  

Use the Text  function (Sketch > Draw...) function to take over contours of texts 
as sketch elements. These can then be used, for the processing of parts with 
sketches (e.g. Subtract, Wrap...). 

» Insertion of variants - Changing of parameter values  
When inserting variants you can now also change the parameter values of the 
selected variant sub-type. In the Parameters area of the dialogue window, simply 
click on the desired value and change it. 

» New algorithm for Boolean operations  
For Boolean operations, a new algorithm with enhanced stability - especially for 
legacy data conversion and foreign data import - is now available. This new algorithm 
is also used for material subtractions or addings. The function dialogue has  not been 
changed due to the new algorithm.  

» Restructured data storage unit.  
The internal HiCAD data storage unit now works in a part-oriented manner. This 
results in a significantly faster updating of Steel Engineering connections and 
assemblies. 

» Lock views of derived drawings 
Views in derived drawings can be locked in such a way that they can no longer be 
rotated out of the screen plane. Some view functions will then be unavailable for 
locked views, namely, all functions that would cause a rotation of the view out of the 
screen plane, e.g. standard views, axonometries, isometries, tramsformations to 
required position etc.  
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» Grid sub-systems  
You can now define so-called Grid sub-systems to refine the structure of 3-D grids or 
Steel Engineering grids. Different sub-systems can be created on the various planes 
of the grid, and can also run diagonally to them. A grid sub-system consists of a start 
point and an end point and is represented as an edge. Along this refined grid, 
constructions can be erected, and the corresponding beams can be placed. 

» Dimensioning - Font/Character set 
On the Dimension figure tab of the Dimension dialogue window, the parameter 
Character set can only be set if no HiCAD font has been selected. 

» Dimensioning - New dimension line termination 
In the 3-D dimensioning settings you can now also choose a half-filled arrow for 
dimension line terminations. In the Configuration Editor (ISDConfigEditor.exe) you 
can specify this setting at ...> Drawing > Annotations > Dimensioning, 3-D > 
Interactive dimensions. 

» Wrap and Clean up 

The Wrap  function can now also be applied to conical shapes and sheets 
consisting of several parts. 

The Clean up  function can now also be applied to conical surfaces 

» Show alignment of active 3-D part in drawing 
Use the Alignment of derived drawings functions to specify for 3-D parts whether the 
active view is to become the front view or the top view in a derived drawing. The parts 
will be identified accordingly in the original drawing. The visibility of this 
representation can be set in the Configuration Editor (ISDConfigEditor.exe) at 
...System settings > Visualisation > Show alignment of the active 3-D part.  
New is the option Switch on/off with F6 key. If this option has been selected, the 
indication of the alignment in HiCAD can be switched on or off via the F6 key (default 
setting). 

» Changed behaviour of main assemblies 
If your drawing contains a main assembly, HiCAD will proceed as follows when you 
create a super-ordinate dummy part: The dummy part will become the (new) main 
assembly and inherits (apart from the part name) all HELiOS properties from the 
previous main assembly, which will become a normal assembly.  
Referenced main assemblies can no longer be cloned. If you try to clone a 
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referenced main assembly, HiCAD will display an appropriate error message. When 
you clone a non-referenced main assembly, the clones will be placed as normal 
assemblies below the main assembly. In this case, there will be no difference 
between the settings "Without superordinate part" and "Create superordinate part". 

 

» Settings for Boltings - Automatic Assembly Generation 
If the parameter Modelling > Change of part structure > Main parts and sub-parts 
automatically in assemblies has been set to Yes… in the Configuration Editor 
(ISDConfigEditor.exe), the options 

 Bolt assignment – 1st part 

 Bolt assignment – Active partktives Teil 

 Auxiliary parts – Sub-part 

will be greyed out in the Settings dialogue window for boltings.  

 

12.3.4 Sheet Metal 

» Mitre  

 The Mitre functions have been revised, now enabling an identification of 
longitudinal sides of sheets via right-click.  

 Mitre cuts are now also available as Design Variants.  

» Adjust bend zone  
A convenient and intuitive dialogue window is now available for the adjustment of 
bend zones. In this window, the functions Adjust bend zone (External transition) 
and Adjust bend zone (Internal transition) have been combined. 

» Design Variant 'Cam joint' 
In practice, so-called cam joints are used for a quick positioning and welding of 
sheets. The new Cam joint Design Variant enables you to conveniently connect two 
base sheets with each other. 

» ABWPAR.DAT  
The default setting for the parameter Dimensionings via edge for development in the 
ABWPAR.DAT file has been changed. 
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Abmessungen aus Abwicklungskante (1 = §L2D,§B2D,§T2D) (2 = 1 + §02,§03,§04) 
(3= 1 + §04) [Dimensionings via edge for development (1 = §L2D,§B2D,§T2D) (2 = 
1 + §02,§03,§04)] 
2. 

» BOM template for sheets  
A revised BOM template called HICAD_Blech_01.RMS is now available for sheet 
metal processing. 

» Checking blank sizes via Design Checker 
You can now use the Design Checker (on the Information tab, select 3-D, Others > 
Design Checker ) to check whether the blank sizes of sheet developments exceed the 
maximum dimensions according to the sheet dimensioning table in the Catalogue 
Editor (Factory standards > Sheet dimensions). The sheet dimensioning table in the 
Catalogue Editor contains the practice-oriented dimensions (Column L1 and W1) for 
the corresponding materials and sheet thickness (Column T). If desired, you can add 
further data records in the table). 

» Bend zone tooling  
The allowance tables of the machine manufacturer LVD can be used in HiCAD for 
the calculation of allowances. When assigning LVD tools to bend zones, bend radii 
and allowance methods will be adjusted. With the help of a concrete example, you 
can now track the single processing steps, from tooling to data export to CADMAN-B 
(from Version 7.5) by LVD. 

 

12.3.5 Plant Engineering / P+ID 

» Update of the Plant Engineering and Pipeline planning modules 
If you have used the modules 3-D Plant Engineering or Pipeline Planning in a HiCAD 
version older than HiCAD 2014, please read the information given in the  5.8 
“Important Notes on Updates” topic.  

» Updating of part files and adjustment of the database 
If you have already created Plant Engineering parts with an older HiCAD version (i.e. 
before HiCAD 2014), you will normally want to use these parts in newer versions as 
well. 
The required procedure is explained in the Online Help. 
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» VarUpdate.exe  
You use this tool for the conversion of part files to the archive file format (file 
extension: .paa or .vaa). In contrast to older HiCAD versions, it can only be started 
automatically from HiCAD if Catalogue has been set as the part data source (Settings 
> Settings > Part selection > Parts from: Catalogue). If you select Database as part 
data source, DbPlantDataImport.exe is used as the central update tool for Plant 
Engineering. This tool will in turn call the VarUpdate.exe program if required. The 
links that were previously defined by VarUpdate.exe, as well as all other required 
links will now be set up by DbPlantDataImport.exe.  

» DbPlantDataImport.exe  
This program is the central tool for the updating of the database, which is required 
for the current version of the HiCAD Plant Engineering module. When you create or 
open a new Plant Engineering drawing file, HiCAD will display a corresponding 
message if an update via DbPlantDataImport.exe will be required. 

In Version 2014, DbPlantDataImport.exe has been enhanced as follows: 

 When you click the Update HELiOS for Plant Engineering button, the links 
required for the Plant Engineering module of the current HiCAD version will 
additionally be entered into the database if they do not already exist. The links to 
be entered are defined in the file PlantpartLinkage.dat in the HiCAD SYS 
subdirectory.  

 As of Version 2014, the part files (.vaa and .paa) supplied with HiCAD will contain 
text attributes in several languages. Accordingly, the Part data synchronisation 
dialogue window now contains an pre-selection option for the desired language in 
which the attribute values are to be entered into the database. 

» Enhanced Variant Editor dialogue  

 When entering constant attribute values, you can now choose the corresponding 
values from a selection box, if any lists with suggested value lists or selection lists 
exist for the displayed attributes. Please note however that this is only possible if 
the Variant Editor can access HELiOS. 

 To assign a database attribute to a variable, or change an existing assignment, you 
can now click [...] in the desired row. 

» PAA-Editor 
When entering attribute values you can now choose the corresponding values from a 
selection box, if any lists with suggested value lists or selection lists exist for the 
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displayed attributes. Please note however that this is only possible if the PAA Editor 
can access HELiOS. 

» Part data synchronisation with language selection 
As of Version 2014, the part files (.vaa and .paa) supplied with HiCAD will contain 
text attributes in several languages. Accordingly, the Part data synchronisation 
dialogue window now contains an pre-selection option for the desired language in 
which the attribute values are to be entered into the database. 

» Elbolets on 90° elbows 
You can now also use so-called Elbolets as branchings for 90° elbows. The Elbolet is 
mounted to the elbow in such a way that its centre axis stands perpendicular on one 
of the two connecting surfaces of the elbow, and runs through the corresponding 
connecting point. 
For the utilisation of Elbolets, the variant Elbolet.vaa and the part classification class 
Elbolet are available. Use the DbPlantDataImport.exe tool to update your database. 

» Drawing of guidelines with down-grade 
Guidelines can now be drawn with a specified down-grade. This option is available 

for the functions Draw guidelines (only via end points)  and AutoGuideline 

. 

Please note the following changes in connection with the drawing of guidelines and 
the placing of parts onto them: 

 The dialogues oft he functions Setttings - AutoGuidelines and Settings – Place 
parts at Plant Engineering > Settings > Settings... have been changed. 

 Changed behaviour of function during placing of parts onto guidelines 
If the start point of the new guideline is placed on the start point or end point of an 
already existing guideline belonging to the same pipeline, the existing guideline 
and the new guideline will be merged into one within the resulting, new guideline 
part. The corresponding previous part of the existing guideline will then no longer 
exist. The new guideline always adopts with its first edge the direction of the 
existing guideline, except in cases where a down-grade has been specified. 
Without a down-grade, the two edges converging in the start point of the new 
guideline will be merged. The same applies to the end point of the new guideline 
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» Insertion of pipe parts/components via P+ID 

After insertion of a pipe part or a component using the Determine via P+ID  
option, the P+ID viewer window will be redisplayed immediately, to enable the 
selection of the next symbol. 

» Isometry - Item numbers according to flow direction 
The assigning of part, connection and length item numbers is based on the 
respective flow directions. Select Isometry > Finishing > ExItmNo  > ... to open a 
pull-down menu with further functions for the exchanging or renewal of item 
numbers. 

» Isometry - Check plausibility of flow directions 
Before HiCAD 2014 you distinguished between two types of flow directions, namely: 
"automatically generated flow directions" and "flow directions specified by the user". 
During editing of the flow direction arrows, the former ones could change their 
direction automatically if the isometry deemed this necessary to keep the flow 
directions plausible. For example, it was prevented that substances could only flow 
into, but not out of a pipe junction. However, the automatic switching of the flow 
direction was not very transparent and could have surprising effects, especially as 
these could easily be overlooked. Therefore, HiCAD 2014 will no longer distinguish 
between these two types of flow directions: Instead, only the flow directions that you 
explicitly select will be changed. 
To check the consistency of the flow, select: Isometry > Symbols > Check 

plausibility of flow directions .  

 

12.3.6 Steel Engineering 

» Railing Configurator - New feature names 
The following feature names will now be used for railing configurations, depending on 
the selected design variant: Railing along beams or Railing along edges. 

» Railing Configurator - Dialogue window 
Some minor changes have been applied to the Railing Configurator dialogue window. 
The Post - Beam tab has been renamed to Post - Substructure. On this tab, 
explanatory graphics for the variants Post connection, top and Post connection, 
lateral are now available. 
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» Railing Configurator: BOM-relevance of Railing assemblies 
The BOM-relevance of the assemblies to be created by the Railing Configurator can 
be set in the Configuration Editor (isdconfigeditor.exe), at Steel Engineering > 
Products > Railing.  

» Beams + Profiles - Indication of orientation 
When you insert a Steel Engineering beam, the orientation of the beam , i.e. the axis 
direction (in the Special colour X-axis), top/bottom (in the Special colour Z-axis), 
left/right (in the Special colour Y-axis), and the rotation axis will be indicated at its 
start. The indication appears as soon as the beam becomes visible, and its position is 
still modifiable. Besides the orientation, a rotation arrow will be iadditionally indicated.   
The indication of orientation can be set in the Configuration Editor , at ... > System 
settings > Visualisation > Indicate orientation of active Steel Engineering beam. 

» Series beams + profiles - Parameterisation in feature log 
When inserting series beams and profiles via the HiCAD Catalogue, the table ID and 
the data record ID will be entered into the feature log. If these IDs are edited in the 
feature log, and a feature recalculation is performed subsequently, new bodies that 
correspond to the specified IDs will be generated. Instead of the IDs you can also use 
variables names, enabling the parameterisation of series beams and profiles in the 
feature log. 

» Grid sub-systems 
You can now define so-called Grid sub-systems to refine the structure of 3-D grids or 
Steel Engineering grids. Different sub-systems can be created on the various planes 
of the grid, and can also run diagonally to them. A grid sub-system consists of a start 
point and an end point and is represented as an edge. Along this refined grid, 
constructions can be erected, and the corresponding beams can be placed. You can 
find the function in the context menu for grids. You open the context menu by right-
clicking the grid. 

» Pipe connection 1501, with cut plane 
For Pipe connection 1501 you can now set a cut plane for the gusset plate. The 
Gusset plate tab has been extended accordingly for this purpose. 

» Derived drawings: Lock views 
Views in derived drawings can be locked in such a way that they can no longer be 
rotated out of the screen plane. Some view functions will then be unavailable for 
locked views, namely, all functions that would cause a rotation of the view out of the 
screen plane, e.g.: Standard views, Axonometries and Isometries, Transform to 
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required position, etc. 
To activate the locking of views in derived drawings, open the Configuration Editor 
(ISDConfigEditor.exe) and select ...> System settings > Visualisation > Views, and 
set the parameter Automatic locking of new views of derived drawing to Always lock. 
The default setting is Never lock. 

» Derived drawings: New dimensioning rules 
For derived drawings, two further dimensioning rules are available in the 
Configuration Editor: 

 Length of beam sub-parts 
Beams as sub-parts are dimensioned along their entire length (start to end). 
Previously, it was only possible to dimension the position of these profiles via the 
axis if the beams were running perpendicular to the main part.  

 Attached beam sub-parts 
Outer dimensions in the assembly view of beams as attached parts can now be 
dimensioned parallel to the axis of the main part. Previously, it was only possible to 
dimension the position of the attached part relative to the main part. 

 Sub-system... 
Various rules for grid sub-systems 

» Edit connection / Design Variant 
For a subsequent changing of connections and Design Variants you can now use the 
new Edit connection / Design Variants function, as an alternative to the changing of 
connections and Design Variants via the corresponding feature log entries. You will 
find the function at Steel Engineering > Variants.  

» Weight of main assembly 
The weight of the main assembly is assigned to the drawing attribute _SZNATTRD01. 

» New Steel Engineering tests in Design Checker 
New Steel Engineering tests are available in the Design Checker, enabling you to 
check the BOM-relevance of assemblies and main parts, as well as the part 
structure. 

» New BOM template for sawn beams/profiles list 
A new BOM template for the export to Excel is now available: 
hicad_stahlbau_03.rms. Use this template for the creation of sawn beams/profiles 
lists in which the sections (trimmings for web and flange) are displayed.  
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12.3.7 Steel Engineering Drawing Management 

»  Executing HELIOSBIMCONFIG.EXE 
Owing to the new release functionality, customers who had already been using Steel 
Engineering Drawing Management with a version older than HiCAD 2014, must 
execute the program HELiOSBIMCONFIG.exe in the HiCAD exe directory once 
before they can use HiCAD 2014. In this way it will be ensured that links without any 
relevance are created, and that the release-relevance will work correctly when using 
the new functions.  
Customers using Steel Engineering Drawing Management for the first time, do not 
need to perform the steps described above. Here, the corresponding database links 
are automatically set correctly.  
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» Release of drawings 
Drawings created with the Steel Engineering Drawing Management (derived 
drawings) can now be released. For this you can use the following new functions 
provided at Drawing Management > Drawing: 

 Release of drawings of the current model drawing and 

 Release of drawings of the active part incl. sub-parts  

After the release, the permissions to change or delete the corresponding parts will be 
withdrawn. In this way it is ensured that the parts cannot be changed any further in 
the model drawing. For a subsequent change, use the (also new) functions provided 
at Drawing Management > Drawing > Change. 

» Changing of released drawings and revision index 
To change parts of released drawings, use the following new functions provided at 
Drawing Management > Drawing: 

 Change 

 Revision index of a production drawing 

The drawings will be automatically updated after applying the changes. The changes 
will (if set accordingly in the Configuration Editor) be indicated by revision clouds. 

» Revision clouds 
Changes in drawings which have been created with the Change function, can be 
indicated by revision clouds. Whether and when such revision clouds are to be set 
can be specified in the Configuration Editor.  

» Expand drawing 
For a subsequent expansion of drawings you can use the new Expand, via HELiOS 
function provided at Drawing Management > Drawing > Derive ... . 
This function makes sense if, for example, you have all beams or all plates in one 
drawing and want to add a new beam or plate in your model drawing later. 
Previously, an extra drawing needed to be created for these parts. The new function 
allows you to expand the existing drawing instead.  
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» Configuration for Steel Engineering Drawing Management  
The parameters for drawing derivation with Steel Engineering Drawing management 
can be found in the Configuration Editor, at PDM > Steel Engineering Drawing 
Management. 

 

12.3.8 Interfaces  

» Step  
During export of referenced parts to STEP, the geometry data of each identical part 
will be read only once instead of several times, even in case of an export to a single 
file. This results in a more manageable file size. 

» IFC 
If any standard beams/profiles are contained in an IFC file, they will only become the 
corresponding standard parts in HiCAD if the designation of the profiles in the IFC file 
corresponds to those in HiCAD.  
Use the mapping table in the Catalogue Editor (Catalogues > Factory standards IFC 
interface > IFC mapping ISD) to specify how standard parts are to be transferred 
from IFC to HiCAD.  

» Apply parameters from the Configuration Editor 
The dialogue window for the export to general 3-D formats such as STEP, Iges, IFC 

etc. now contains the new  Apply parameters from ConfigEditor button at the 
right hand side, below the interface-specific export options. This button enables you 
to load the export parameters that have been defined in the Configuration Editor for 
the respective format. As the last used parameter settings are always displayed in the 
HiCAD dialogue windows, you can use this button to restore the default settings if 
required.  

» Enhanced 3DPDF and U3D export options 
The export of HiCAD drawings to 3DPDF and Universal3D format now offers the 
following, additional options: 

 You can now export only shown parts instead of the entire drawing if desired 

 specify the faceting accuracy (i.e. the mode of polyhedron approximation), and 

 select between different units of measurement (mm/ cm/ m, inch). 
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12.3.9 Feature Technology 

» External references: Body setting 
In addition to the setting for the body, specifying whether external references are to 
be used generally, you can define for individual feature elements whether these are 
to use external references or not. This means that a particular feature step will then 
have a external reference behaviour that differs from the one that was set for the 
body. If the Body setting option has been set, the external references-related 
behaviour for the body will always be adopted in the feature. 

 

12.3.10 Report Manager  

» New BOM template for sawn beams/profiles list 
A new BOM template for the export to Excel is now available: 
hicad_stahlbau_03.rms. Use this template for the creation of sawn beams/profiles 
lists in which the sections (trimmings for web and flange) are displayed.  

» BOM template for sheets  
A revised BOM configuration called HICAD_Blech_01.rms is now available for sheet 
metal processing. 

 

12.3.11 Catalogue Editor 

» Hexagon head bolts UNC 
Besides UNC and UNF threads, hexagon head bolts are now also available. 

» IFC export 
Use the mapping table at Catalogues > Factory standards IFC interface > IFC 
mapping ISD to specify how standard parts are to be transferred from IFC to HiCAD. 

» Bend zone tooling  
As of Version 2013, HiCAD offers the Bend zone tooling function that enables the 
assigning of tools to bend zones, i.e. radius and allowance method can be adjusted 
in a practice-oriented manner. Currently, data of the machine manufacturer LVD are 
evaluated here. The integration of allowance tables of other machine manufacturers 
is planned for the near future. 
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» Cam joints for sheet metal parts 
As of version 2014, a new Design variant for Sheet Metal parts is available, the so-
called CAM hole connection. When you insert this connection, you can eithet enter 
the length of the CAM hole directly, or apply the pre-settings in the catalogue Factory 
standards > User settings > ISD Cam settings. You can also add further data 
records to the table if desired. 

 

12.3.12 Variant Editor 
When entering constant attribute values, you can now choose the corresponding values 
from a selection box, if any lists with suggested value lists or selection lists exist for the 
displayed attributes. Please note however that this is only possible if the Variant Editor 
can access HELiOS. 

 

12.3.13 Configuration Editor  

» Enhanced configuration structure  

 Additional dimensioning rules for drawing derivations in Steel Engineering 
(Automatic drawing derivation > Use case-dependent > …)  

 BOM-relevance for railing assemblies in Steel Engineering (Steel Engineering > 
Products > Railing)  

 Settings for grid sub-systems in derived drawings (Automatic drawing derivation > 
Annotations > Grid annotation)  

 Settings for grid sub-systems in main drawing (Drawing > Annotations > Grid 
annotation) 

 Indicate orientation of the active Steel Engineering beam (System settings > 
Visualisation) 

 Lock views of derived drawing (System settings > Visualisation > Views)  

 New dimension line terminations for 3-D dimensions (half-filled arrow) (Drawing > 
Annotations > Dimensioning, 3-D > Interactive dimensions).  

 Enhancements of the interfaces for 3D PDF, STL, U3D and VRML (Interfaces 
&gt;).  
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 Parameters of revision clouds for automatic indication of changes in Steel 
Engineering Drawing Management  (PDM > Steel Engineering Drawing 
Management).  

 Settings for the release of drawings derived with the Steel Engineering Drawing 
management (PDM > Steel Engineering Drawing derivation). 

» Additional information on individual entries 
Many entries of the Configuration Editor now contain additional illustrations.  

» Applying of parameters from the Configuration Editor 
The dialogue window for the export to 3-D formats such as STEP, Iges, IFC etc. 
(Drawing > Save as  >  3-D Formats (STEP, ...) ) now contains the new Apply 
parameters from ConfigEditor button at the right hand side, below the interface-
specific export options. 
This button enables you to load the export parameters that have been defined in the 
Configuration Editor for the respective format. As the last used parameter settings are 
always displayed in the HiCAD dialogue windows, you can use this button to restore 
the default settings if required. 
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12.3.14 HELiOS  
 

12.3.14.1 HELiOS Desktop with new Look & Feel  

» The HELiOS Desktop 2014 features a revised and optimised GUI, with a new menu 
structure for an optimised operability.  

» New search dialogues for parts, documents, folders and projects, with new, dynamic 
result lists.  

 Saving of search parameters as re-useable templates.  

 Modification of result lists via Drag & Drop 

 Convenient adding and removing of columns 

 Renaming of column headings 

 So-called “virtual attributes” are attributes in result list rows which, in contrast to 
unambiguous database attributes, do not occur in the data record of a master data 
object, and the values of which need to be calculated.  

» In the data input masks for Parts and Documents it is now possible to assign them to 
a Folder already during their creation (same as for an assignment to Projects. 

» New, user-specific configuration options for GUI elements, without having to use the 
Mask Editor. 

» The Project, Folder, and Product Explorer are operated in a similar way to the 
Explorer area of the Windows Explorer. Here, too, you can open extended context 
menus with editing functions for each object (right-click the object).  

» The general dragging interactions of the HELiOS Desktop, e.g. for the document entry 
via Drag & Drop, have been adapted to comply with the current Windows standard.  

» The Properties and Graphics windows have been further enhanced and optimised; in 
the Graphics window, for example, you can now switch between different views and 
representations of parts in your drawing.  
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» Graphics window with Skip option 
Like the result lists or Explorer views, you can now also individually configure the 
representation of the Properties window. 

 

12.3.14.2 Folders in projects / Projects in Folders 

» You can assign Folders to Projects by dragging them (press ALT key!) from result lists 
into the Project Explorer. 

» Use the  Copy project contents to folder function in the context menu for 
folders to assign the contents of a project to the active folder.  

» Use the  Show project contents via folders function in the context menu of the 
active project to display an overview of all documents and parts of the project which 
are assigned to a folder.  

 

12.3.14.3 Hide / Show documents without access permission 

When configuring the database you can specify whether objects for which the 
corresponding user has no access rights are to be displayed as greyed out items in the 
Desktop, or totally excluded from result lists and overviews. 

 

12.3.14.4 Versioning with different file types  

If you want to change the file type of a modified document, open the context menu of 

the active document and select  Change document (with file selection) function for 
this.   

For example, if you want to import a drawing with a foreign CAD format to the HiCAD 
format, or save text files with an extension other than .txt after applying the changes, 
you can use this function to save the modified file in the desired, new file format to the 
database. 
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12.3.14.5 Labels 

To provide end users with meaningful column headings for result lists, you can assign 
so-called "labels" to database attributes.  

Example: Instead of the real database attribute names "HEL_KOPFID" and 
"HEL_GUELTIG", you can display the corresponding, more meaningful labels "ID of 
part" and "Creation date" in the GUI of the HELiOS Desktop.  

These labels have already been defined for the supplied default standard attributes of 
the HELiOS database. If the user creates any new attributes via the Attribute Editor, 
labels in different languages can also be created for these new attributes. 

 

12.3.14.6 Derive part structure, via CAD structure 

You can now use the new context menu function  Derive part structure, via CAD 
structure to define, via a user-defined selection, which elements of the CAD structure 
are to be taken over into the HELiOS part structure. A dialogue window enables you to 
specify which elements of the CAD structure are to be derived The individual parts will 
be saved to the database with a new document number (and all data except for sheet 
numbers and indices) and will be replaced by the derived parts in the drawing. 
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